# Contents

Welcome ......................................................................................................................... 4

**Getting Started**....................................................................................................... 1
  System Requirements ................................................................................................... 1
  Notes on Installation and Feature Access ................................................................. 1
  Versions of GoToMyPC .............................................................................................. 1
  Mac Users ................................................................................................................ 1

**Upgrade Information** ............................................................................................ 2
  Useful GoToMyPC Terms ............................................................................................ 4
  Features ................................................................................................................... 5

**Set Up a Host Computer** .......................................................................................... 6
  Create Your Account (first-time users) ...................................................................... 6
  Set Up a Host PC .................................................................................................... 7
  Leaving the Host Computer Accessible .................................................................... 8

**Managing Billing and Account Information** .......................................................... 9
  Change Your Password and Account Information ................................................. 10
  Update Your Credit Card and other Billing Information ......................................... 11
    Expense GoToMyPC? .............................................................................................. 11
    Renew or Cancel GoToMyPC ................................................................................. 11
  How to Change Your Plan ...................................................................................... 13
  Print a Copy of Your Receipt ................................................................................. 14
  Change Your Currency, Time Zone and other Settings ........................................... 15

**Accessing Your GoToMyPC Host Mac or PC** ......................................................... 16
  Set Quick Searches ................................................................................................. 17
  Remotely Unlock Your Host Computer .................................................................. 18
  Remotely Lock Your Host Computer ...................................................................... 19
    Remotely Lock a Windows PC ........................................................................... 19
    Remotely Lock a Mac ......................................................................................... 19
  End Your GoToMyPC Connection ....................................................................... 20

**The GoToMyPC Viewer** ......................................................................................... 21
  Viewer Window and Host Image ............................................................................. 21
  Resize Your Viewer Window .................................................................................... 22
  Resize Your Host Mac or PC Image .......................................................................... 23
    The Mac Slider Bar ............................................................................................... 23
  Multi-Monitor Support ............................................................................................ 24
    Manage Multiple-Monitors from a PC Client ...................................................... 24
  Minimap .................................................................................................................. 25

**Universal Viewer** ................................................................................................... 26
Universal Viewer Shortcut ............................................................. 27
Resize Your Host Computer Image .................................................. 27
Lock and Unlock your Host PC with Send Ctrl-Alt-Del ...................... 27
PocketView™ ................................................................................... 28
Accessing Your Host Mac or PC Using PocketView ......................... 28
The PocketView Toolbar and Menu .................................................. 29
PocketView Preferences .................................................................... 31
Using PocketView ........................................................................... 32
PocketView Usage Recommendations ............................................... 33
Using GoToMyPC Features ............................................................... 34
Mac Features and Keyboard Mapping ............................................... 35
Feature Comparison between Mac and PC ....................................... 35
Keyboard Mapping ....................................................................... 35
Right-Click from a Mac Client ....................................................... 36
Remote Printing ............................................................................. 36
   GoToMyPC Printer ................................................................ 37
   Print to a Different Local Printer ............................................. 37
   Manually Enable a Printer ..................................................... 38
   Locate and Install a Printer Driver on the Host Computer .......... 40
File Transfer .................................................................................. 41
   Drag and Drop Files between PCs ......................................... 42
File Sync ....................................................................................... 43
   Repeat a Recent File Sync ..................................................... 44
Remote Sound ............................................................................... 45
Sound Features ........................................................................... 46
Session Performance ...................................................................... 47
Guest Invite .................................................................................. 48
   Connect to an Invited Guest .................................................. 49
   Change Guest Access ......................................................... 50
   Chat ................................................................................... 50
   Drawing Tools in Guest Session ........................................... 51
Cut/Copy and Paste ........................................................................ 52
Desktop Shortcut ........................................................................... 53
   Create a Shortcut on a PC .................................................. 53
   Access a Host with a Desktop Shortcut ................................ 53
   Revoke All Desktop Shortcuts ............................................. 54
   Create a Web Shortcut on a Mac ........................................... 54
   Create a Desktop Shortcut on a Mac ..................................... 54
   Reconnect ........................................................................... 56
Welcome

GoToMyPC® is for individuals needing remote desktop access to 1-20 computers. It’s an easy and secure remote-access solution that enables you to conveniently access email, files, programs and network resources from home or the road. Get unlimited access to your computers from any Web browser anywhere.

This help contains information for all GoToMyPC user plans including GoToMyPC Personal, GoToMyPC Pro and GoToMyPC Corporate. Some content may not apply to your plan.

- **Teleworkers**: Work on your office Mac or PC from home, easily and securely, with just an Internet connection.
- **Travel**: Access and use your Mac or PC and files from hotels, airports, Internet cafes – anywhere with Web access.
- **After-Hours Access**: Access and use your office desktop, email and other corporate resources after hours from any location connected to the Internet.
- **24/7 Global Customer Support**: Get help any time – day or night – from our U.S.-based Customer Support at 1-888-259-3826.
Getting Started

This guide shows you how to set up your PC with GoToMyPC and access it from another computer. It also explains the main features of GoToMyPC so that you can begin working quickly.

System Requirements

Host Computer: for the Mac or PC that you want to remotely access, the following are required:

- Microsoft® Windows® 2000, XP, Vista, Windows 7, Mac® OS X v10.5 (Leopard®) (Linux is not supported)
- Internet Explorer® 5.0 or newer; Firefox® 2.0 or newer, Safari™ 3.0 or newer
- JavaScript™ and Java™ enabled Web browser
- "Always on" Internet connection (cable, ISDN, DSL or better)

Client Computer: To access your host computer using a Mac or PC, the following are required:

- Microsoft Windows 2000 or newer; Mac OS X v10.4 (Tiger®) or newer
- Recommended: Microsoft Windows XP or newer
- Internet Explorer 6.0 or newer; Firefox 2.0 or newer; Safari 3.0 or newer
- Broadband Internet connection with cable modem, ISDN, DSL or better recommended

Client Computer: Universal Viewer for Windows - Limited Features

- Microsoft Windows with Internet Explorer 5.0 or newer, Firefox 1.0 or newer; and Sun Java
- Recommended: The Sun Java™ 2 Standard Edition (J2SE) version 1.4 or newer

Client Computer: Universal Viewer for Mac - Limited Features

- Mac OS X with Safari™ 1.0 or newer or Firefox 1.0 or newer; and Sun Java

Client Computer: Universal Viewer for Linux and Solaris™ - Limited Features

- Firefox 1.0 or newer; and Sun Java

Client Computer: Universal Viewer on other platforms - Limited Features

- Other operating systems and browsers that support Java and have a full Java 2 Standard Edition JVM should work but have not been tested

Client Computer: PocketView™ for Windows CE™ - Limited Features

- Microsoft Windows Phones running Window Mobile™ 6.5 Pro
- Microsoft Windows Mobile 6.0 Classic and Pro
- Microsoft Windows Mobile 5.0 for Pocket PC or Pocket PC Phone Edition
- Most devices running Microsoft Windows CE 5.0 or later with a touch screen or mouse (such as thin clients)
- Internet Explorer, Pocket Internet Explorer, or equivalent Web browser

Note: Windows Mobile versions that lack a touchscreen are not supported. This includes Windows Mobile 6.0 Standard or newer and Windows Mobile 5.0 for Smartphones.

Note: PocketView is not available for Blackberry® or iPhone ®
Notes on Installation and Feature Access

Please keep the following information in mind when installing and using GoToMyPC:

- Because of various operating system restrictions, GoToMyPC requires the service to be installed on the host Mac or PC with administrator rights enabled. Please see your administrator for assistance.
- Because of various operating system restrictions and hardware requirements, some features of GoToMyPC may not function on some computers. For Server 2003 as a host PC, the www.gotomypc.com Web site must first be added as a trusted site.
- If you are GoToMyPC Corporate or Pro user, your administrator has the ability to restrict access to features and/or to require the use of some features. If you have questions about your feature-access rights, please see your administrator for assistance.

Versions of GoToMyPC

There are three versions of GoToMyPC.

- GoToMyPC - Secure remote access for individual users
- GoToMyPC Pro - Secure remote access for teams and small companies
- GoToMyPC Corporate - Secure remote access for small and medium-sized businesses

Mac Users

GoToMyPC users can now access their Mac and PC hosts. Significant differences in how GoToMyPC works on the Mac platform are highlighted with this icon.

Mac
Upgrade Information

GoToMyPC will notify you when new updates are available. If you are on a PC, you can also check for new updates at any time by right-clicking the system tray icon (usually located in the lower-right corner of your screen near the clock) and selecting Check for Upgrade. If a new version exists, you will be notified and asked if you want to upgrade.

**Note:** You can upgrade GoToMyPC versions 5.0 and higher while remotely connected to your host PC.

If you want to upgrade, click Yes; if not, click No. If you click Yes, GoToMyPC will download the new version and prompt you to reinstall with the install wizard.

Should the automatic upgrade fail, you will need to manually upgrade the service. Simply open a Web browser, go to [http://www.gotomypc.com/setupSoftware.tmpl](http://www.gotomypc.com/setupSoftware.tmpl) and follow the directions.

What's new in 7.0?

- **Mac Support:** Native Mac viewer includes display options like zoom, full screen and multi-monitor support.
- **Cross-Platform Access:** Flexibility to work PC to PC, Mac to Mac, Mac to PC or PC to Mac.
- **Cross-Platform Support:** Tools to support cross-platform access like keyboard mapping, Cut/Copy and Paste, Send Ctrl-Alt-Delete and Set Right-Click.
- **Windows 7 Compatibility**

What's new in 6.1?

- GoToMyPC 6.1 includes additional support and stability for host PCs with Windows Vista.
- The latest GoToMyPC upgrade resolves an issue identified after the release of Vista Service Pack 1. Files transferred with the Drag and Drop feature to PCs with Windows Server 2008 or Vista SP1 could be corrupted. Any host PCs on Vista or Server 2008 SP1 should be upgraded to build 438 or later.

What's new in 6.0?

- **Sound:** Enjoy your remote session even more with new customizable sound support.
- **In-Session File Sync:** Easily synchronize your files and folders between the host and client.
- **Shortcut/Reconnect:** Bypass the normal browser login screen with the Shortcut feature. Receive notification before a session is terminated due to inactivity and quickly reconnect.
- **GoToMyPC Printer:** Quickly print from your client PC with the new GoToMyPC Printer driver. Setup and printer driver installations are no longer needed.
- **Guest Invite:** Share your PC with a guest faster and with more control.
- **Vista Compatibility:** GoToMyPC is now compatible with Microsoft Vista.
- **Universal Viewer:** Universal Viewer support is improved and has added functionality.
Can I upgrade while in session?
Yes, you can upgrade GoToMyPC versions 5.0 and higher while remotely connected to your host computer.

How to upgrade GoToMyPC?
GoToMyPC will notify you when new updates are available. On a PC, you can also check upgrades.

1. Right-click the icon in the system tray and select Check for Upgrade.
2. If available, click Yes to upgrade.
   The new version will download and InstallShield Wizard will start. Click Next.
3. Make sure the Update option is selected and click Next.
   InstallShield Wizard will close and update GoToMyPC.
4. When prompted, click Finish to complete the upgrade process.

Note: Should the automatic upgrade fail, you will need to manually upgrade. To manually upgrade, open a Web browser, go to www.gotomypc.com/setupSoftware.tmpl and follow the directions.
Useful GoToMyPC Terms

- **Access Code** – Your access code is the unique password that you set up for each host Mac or PC. You will use the access code every time you log in to a host computer remotely.
- **Account Password** – Your account password is what you use to log in to the GoToMyPC Web site.
- **Client Computer** – The client computer is the computer that you will use to access the host Mac or PC. It can be any Internet-connected computer with a Windows or Java-enabled browser, located anywhere in the world (airport kiosk, Internet cafe, hotel, library, etc.).
- **Computer Nickname** – The computer nickname is the name you assign to a host during installation of GoToMyPC software. Using nicknames helps you identify your computers if you set up more than one for remote access. It can be any name you choose: Office, Home, Laptop, Rover - you decide.
- **Host** – The host is the Mac or PC you will want to access from a remote location. You will install the GoToMyPC software on the host Mac or PC. The host computer is a unique and specific computer.
- **Host image** – The host image is the picture of the host Mac or PC desktop that appears in the Viewer window.
- **One-Time Passwords** – One-Time Passwords offer an additional level of security for users. This feature will help defeat keyboard-sniffer or keystroke logger software.
- **RADIUS** – RADIUS is a two-factor authentication method based on something you know (a password or PIN) and something you have (an authenticator), providing a more robust level of user authentication. RADIUS is available on GoToMyPC Corporate.
- **Session** – A session refers to the time you are remotely connected to your host computer.
- **System tray icon** – The system tray icon represents the status of the GoToMyPC service on PCs and is used to access GoToMyPC preference and setting options. To access system preferences, right click the system tray icon and select Preferences. The system tray is located at the bottom right of Windows PCs next to the clock.

<table>
<thead>
<tr>
<th>Status state representations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Icon</strong></td>
</tr>
<tr>
<td><img src="image" alt="Status" /></td>
</tr>
<tr>
<td><img src="image" alt="Status" /></td>
</tr>
<tr>
<td><img src="image" alt="Status" /></td>
</tr>
<tr>
<td><img src="image" alt="Status" /></td>
</tr>
<tr>
<td><img src="image" alt="Status" /></td>
</tr>
</tbody>
</table>

- **Viewer** – The Viewer is the window displayed on your client computer in which the host's desktop will appear. The Viewer window has its own title and menu bar.
Features

**Automatic Setup:** Plug-in automatically launches, installs and configures itself. No restart required. Even novice users can be ready to go in minutes.

**Universal Viewer:** When you connect to your computer, the Viewer window launches automatically, allowing you to view and control your PC from another Windows, Windows CE, Mac, Linux, Unix or Solaris computer. No pre-loaded software required. Access your computer from any Web browser on any operating system at any time.

**PocketView™ Wireless Access:** Securely access your computer from your wireless Pocket PC device running Windows Mobile 2003/2003SE or later from your device running Windows CE 4.0 or later. Provides ultimate mobility.

**Drag-and-Drop File Transfer (PC to PC only):** Easily transfer files by dragging and dropping folders and directories between computers. You never again need to email files to yourself or copy to a USB flash drive. Get access to your files at any time from anywhere.

**File Sync (PC to PC only):** Synchronize files and folders between your remote PC and any other computer with just a click.

**Sound (PC to PC only):** Hear sound on your remote PC with customizable audio settings. Automatic muting on your remote PC means sound can only be heard by you.

**True Color:** View your desktop in brilliant true color.

**Performance Tuning (PC only):** Adjust the speed, sound, color quality and display settings to get the performance that best suits your needs.

**Multi-Monitor Support:** Use GoToMyPC with multiple monitors connected to a single computer.

**Remote Printing (PC to PC only):** Print documents to any printer wherever you happen to be – there’s no need for the application that created the document to be installed on the client PC. A hard copy of that forgotten file is only a connection away.

**Cut/Copy and Paste:** Cut, copy and paste text between computers. Simplifies transfer of content between desktops.

**Encryption and Maximum Security:** All data is protected with AES encryption using 128-bit keys. Dual passwords and end-to-end user authentication. Option to use One-Time Passwords for maximum security. Most secure Internet connection available in a remote-access product.
Set Up a Host Computer

Before you can access your host Mac or PC remotely, you first need to create your account (first time users), install the GoToMyPC software and leave the Mac or PC accessible. To install the software, you will need to be at the Mac or PC and have the email address and password you used to register.

**Note:** To enable all features and functionality, GoToMyPC needs to be installed with Administrator Rights, therefore, Corporate and Pro users please contact your administrator for assistance; in some instances, your administrator may install GoToMyPC Corporate for you using a remote installation process.

Create Your Account (first-time users)

► To create a personal GoToMyPC account

1. New GoToMyPC users can sign up for service at www.gotomypc.com.
2. Select the Free Trial or Buy Now link on the upper left side of the page.
3. Enter your name and email information and then click Continue.
4. Create a new account password with at least eight characters using both letters and numbers and then click Continue.
5. Enter your billing information and then click Get Free Trial or Buy Now.
6. If you are sitting at the computer you wish to access from anywhere then click Yes, Install GoToMyPC. Please continue with the Step Two – Install the software instructions. If you are not, then go to the computer you wish to install GoToMyPC on and continue with the Step One – Download the software instructions.

► To create a GoToMyPC Corporate or Pro account

1. In most cases you will receive an email invitation from your company administrator to set up your GoToMyPC Corporate or Pro account. Go to your email account and open the email titled Set Up GoToMyPC.
2. Click the link in the email to activate your account (first link in email). A new browser window opens and prompts you to create your account.
3. Enter your first and last name, create and confirm your account password, click Submit.
4. If you are sitting at the computer you wish to access from anywhere then click Install GoToMyPC. Please continue with the Step Two – Install the software instructions. If you are not, then go to the Mac or PC you wish to install GoToMyPC on and continue with the Step One – Download the software instructions.
Set Up a Host PC

To set up a host Mac or PC for remote access

Step One - Download the software

1. Be sure you are at the Mac or PC you will want to access remotely; this will be the host.
2. Open a browser window and go to www.gotomypc.com.
3. Enter your email address and account password and click the Log In button.
4. First-time users, or users without any PCs set up, click the Install GoToMyPC button. Returning users who have more than one license can add additional host PCs from this screen.
5. Depending on your browser, click Trust, Yes, Allow or Grant to begin downloading the GoToMyPC software.

Step Two - Install the software

1. Click Continue or Next at the Welcome screen begin installation.
2. If prompted, select an install location and then click or Install from the Install screen.
   - Mac Installation: You will be prompted to enter your Mac login password. This is the password you normally use to install new Mac software and is not a GoToMyPC password.
   - PC Installation: If you intend to use Windows' Fast User Switching feature during this session the select "Yes, I want to restart my computer now" and click Finish.

   Note: If you are using security or firewall software, you must permanently allow GoToMyPC to connect to the Internet. See Using GoToMyPC with Firewalls for more information.

   Note: If you are a GoToMyPC Corporate user in an environment that requires authentication to access the Internet, you will be prompted to enter your GoToMyPC Corporate account login information during setup. Please contact your administrator for further details.

3. When prompted, enter your email address and account password (these are the same that you used to log in to the GoToMyPC Web site) and click Continue.
4. If needed, select the GoToMyPC account to which this computer should belong.
5. Create a nickname for the host Mac or PC and click Continue.
6. Give the computer an access code and click Continue.

   Note: If you forget your access code or wish to change it, you can quickly create a new one from your host computer. Please see Forgot Your Access Code for details.

   Note: For the highest level of security we recommend that your access code be different from your account password.

   - Mac Installation: Now that GoToMyPC has been successfully installed you will see the GoToMyPC icon at the top right of your screen in the Mac menu bar.

   "Top right of your screen." "logged in, 3:13 PM"

   - PC Installation: Successful PC installation can be confirmed by viewing the icon at the bottom right of your screen in the system tray.
Leaving the Host Computer Accessible

To be able to access your host Mac or PC from a remote client computer, you need to ensure that your host meets the three following conditions:

1. The host is turned on and not in sleep mode.
2. The host is connected to the Internet with a live connection.
3. The GoToMyPC service is running.

**Note:** To help ensure security, you may want to lock your Mac or PC before you leave it unattended.

**Note:** Since GoToMyPC does not require the display monitor on your host, you may want to turn it off before you leave to conserve energy. You can also set your monitor to automatically power down after a specified time.
Managing Billing and Account Information

You can view and edit your account information by logging in at www.gotomypc.com and selecting My Account from the left navigation menu.

This section of the GoToMyPC Website enables GoToMyPC and GoToMyPC Pro customers to view or edit their account and billing information, change their account password and much more.

Note: GoToMyPC Corporate customers should contact their account manager for account and billing related questions.

To view and edit your account information

2. In the left navigation menu, select My Account.

Select from the following account options from the expanded My Account menu.

- **My Account**: Edit the name on the account, change your password and enable the Remember Me feature.
- **Billing Info**: Update your credit card information, change your billing address and manage subscription options
- **Plan Selection**: Add computers, change your plan type, see pricing information or upgrade to GoToMyPC Pro
- **Account History**: View your current balance and print a billing receipt
- **Settings**: Change your location and language settings as well as manage your email subscriptions and Desktop Notifications.
Change Your Password and Account Information

You can view your account status, manage account details, change your password and enable the Remember Me feature by logging in to www.gotomypc.com and selecting My Account from the left navigation menu.

**Note:** GoToMyPC Corporate users may have some features disabled by their administrator.

To view and edit account information

2. Select My Account in the left navigation menu.
3. Enter your current password and make any desired account or password changes. Click the Save Changes button at the bottom of the page.
**Update Your Credit Card and other Billing Information**

If you are a GoToMyPC or GoToMyPC Pro user then you can update your credit card and billing information (a) very easily by logging in at [www.gotomypc.com](http://www.gotomypc.com) and selecting the Billing Info link from the expanded My Account menu in the left navigation pane.

**Note:** GoToMyPC Corporate customers should contact their account manager for account and billing related questions.

**Note:** On-line credit card payments are processed over our secure server.

**Expense GoToMyPC?**

If you plan to expense your GoToMyPC service then select the option to include additional business information (b).

**Renew or Cancel GoToMyPC**

With *Subscription Options* you can decide what will happen with your GoToMyPC account after the current plan expires (c).

**To renew or cancel GoToMyPC after the current plan expires**

1. Log in to your account at [www.gotomypc.com](http://www.gotomypc.com).
2. Select the Billing Info link from the expanded My Account menu in the left navigation pane. You can also call Customer Service toll-free at (888) 259-3826. If you are calling from outside the United States or Canada, please use one of our international telephone numbers.
3. From the Subscriptions Options section, select an option once the current plan expires.

**Note:** You can also contact Global Customer Service to cancel your account.

**Note:** Because GoToMyPC is a pre-paid service, your service will continue until the end of your current paid subscription period. At that time, your plan will be discontinued and will not renew again.
### Billing Information

#### Credit Card Information: Current

<table>
<thead>
<tr>
<th>Credit Card Number:</th>
<th>Type:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Choose one...</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Full Name on Credit Card:</th>
<th>Expiration Date:</th>
<th>Card Security Code:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MM</td>
<td>YYYY</td>
</tr>
</tbody>
</table>

**Note:** All payments are processed on our secure server and will appear on your credit card statement as charges made to GoToMyPC Services.

#### Billing Address

<table>
<thead>
<tr>
<th>Street 1:</th>
<th>Street 2:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(Optional)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>City:</th>
<th>State/Province:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Choose one...</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ZIP/Postal Code:</th>
<th>Country:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>United States</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phone:</th>
<th></th>
</tr>
</thead>
</table>

**Plan to expense this account later?** [Enter Business Information]

#### Subscription Options

- [ ] When my plan expires, please renew my account and automatically charge my credit card to ensure uninterrupted service.

- [ ] When my plan expires, please cancel my account and do not automatically renew my current plan.

[Save Changes]
**How to Change Your Plan**

If you are a GoToMyPC or GoToMyPC Pro user then you can view or modify your plan selection and billing options at anytime by logging into your account at [www.gotomypc.com](http://www.gotomypc.com) and selecting *Plan Selection* from the expanded *My Account* navigation menu.

From this page you can view your current plan (a), add or remove the number of PCs, select whether you want an annual or monthly plan (b) and change your location settings (c). If you'd like administrative features that allow you to manage multiple users then you can also upgrade your account to GoToMyPC Pro (d).

**Note:** GoToMyPC Corporate customers should contact their account manager for account and billing related questions.
Print a Copy of Your Receipt

If you are a GoToMyPC or GoToMyPC Pro user you can review your account activity, print receipts and change your location settings by logging into your account at www.gotomypc.com and selecting Account History from the expanded My Account navigation menu.

Note: GoToMyPC Corporate customers should contact their account manager for account and billing related questions.
Change Your Currency, Time Zone and other Settings

GoToMyPC and GoToMyPC Pro users can view and edit their account settings by logging into their account at www.gotomypc.com and selecting Settings from the expanded My Account navigation menu.

Customizable account settings include location settings, time zone (a), email notifications (b), and Desktop Notifications (c).

To view or edit your account settings
1. Log in to the GoToMyPC Web site.
2. In the left navigation bar, select My Account and then Settings.
3. Complete desired changes and click the Submit button.
Accessing Your GoToMyPC Host Mac or PC

Once GoToMyPC is set up and running on your host Mac or PC, you can access it immediately from almost any other client computer with Windows, Mac or a Java-enabled browser that is connected to the Internet, such as from computers at airport kiosks, Internet cafes, hotels, etc.

To remotely access your host, you’ll need to be at a client computer (any computer other than the host you just set up) and you will need to know your email address, password and access code.

To remotely access your host computer
2. Enter your Email address and account Password and click Log In.
3. If prompted, choose the account you want to access and click Go (only applies if you have multiple GoToMyPC accounts associated with one email address). This will load your My Computers page.
4. To the right Nickname of the computer, click the Connect button.
5. Depending on your browser, click Run, Always, Allow or Trust to download the GoToMyPC Viewer. PocketView users will need to click the Download link to begin download.
6. When prompted, enter your access code for the host and click OK.
7. The host image will appear in the Viewer window.

You are now connected to your host Mac or PC and ready to start accessing all your files, applications and email as if you were sitting at your computer!

**Note:** If a Mac or PC's status is Offline, then you will not be able to access that host. To access a host computer, you need to leave the computer on and connected to the Internet with GoToMyPC running. See Leaving the Host Computer Accessible for more information.

**Note:** If you are a GoToMyPC Corporate user and your host is a shared PC that is being accessed by another GoToMyPC user, "In Session" will appear in the connect box. If you choose to connect to a PC while it is in session, the session in progress will be terminated. Keep in mind that the In Session notification will display until the first user terminates the connection with the host PC and you refresh your browser.
**Set Quick Searches**

If your account has more than 10 GoToMyPC seats accessed by the same email address, you can quickly locate a favorite host computer with the Quick Searches feature.

▶ **To set a Quick Search**

1. Select a Quick Searches number that you would like associated with a common search.
2. In the Search field enter a host computer nickname; or portion of a nickname if you use the * wildcard option.
3. Click the **Set Quick Search button** to save the search for future use.
4. The next time you need to initiate a saved search from the Computer List, simply select the Quick Searches number to view your host Mac or PCs.

**Note:** This feature is limited to 5 saved searches but a number can be reassigned at anytime.

---

### Computer List

<table>
<thead>
<tr>
<th>Nickname</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;1Test&quot;</td>
<td>Connect</td>
</tr>
<tr>
<td>&quot;2k Test machine&quot;</td>
<td>Connect</td>
</tr>
<tr>
<td>&quot;2k Machine&quot;</td>
<td>Connect</td>
</tr>
<tr>
<td>&quot;2k&quot;</td>
<td>Connect</td>
</tr>
<tr>
<td>&quot;3XP&quot;</td>
<td>Connect</td>
</tr>
<tr>
<td>&quot;32-FUS&quot;</td>
<td>Offline</td>
</tr>
<tr>
<td>&quot;32-XP FUS&quot;</td>
<td>Offline</td>
</tr>
</tbody>
</table>

---

"GoToMyPC® User Guide

© 2009 Citrix Online, LLC. All rights reserved.
Remotely Unlock Your Host Computer

After you have successfully connected to your host Mac or PC, it most likely will be locked. In most cases, you will just need to enter your Windows or Mac system password. Your operating system determines the unlock method.

To unlock 2000, XP Professional, Vista or Windows 7 use the Send Ctrl-Alt-Del feature

Note: If the Send Ctrl-Alt-Del feature is not functioning on a host PC with Vista or Windows 7 then the Secure Attention Sequence (SAS) may be disabled. Please see Enable GoToMyPC to Send Ctrl-Alt-Delete on Vista and Windows 7 for more information.

1. From the Viewer menu, choose Tools, then Send Ctrl-Alt-Del; or you can click the Send Ctrl-Alt-Del button in the upper right-hand corner of the Viewer window.

2. Enter your Windows password to unlock your PC as you normally would using your network ID and Password.

To unlock Mac OS X v10.5 and XP Home (or XP Professional with Fast User Switching)

1. If the screensaver is running, move the mouse to deactivate it.
2. This displays the logon screen.
3. Log in to your Mac or PC as you normally would.
**Remotely Lock Your Host Computer**

When you are through using your host Mac or PC, we recommend that you lock your computer to help protect your data. PC users can set the GoToMyPC Security Preferences to automatically lock upon disconnect. If you wish to do so manually, your operating system will dictate the method you will use to lock your Mac or PC.

**Remotely Lock a Windows PC**

▸ *To lock Windows 2000, XP Professional and Vista*
  1. Complete all activities on your host PC.
  2. Click the Windows **Start** button and Select **Log Off**.
     - Or -
  2. From the GoToMyPC Viewer menu bar, choose Tools, then **Send Ctrl-Alt-Del**. Or click the **Send Ctrl-Alt-Del** shortcut button in the upper right-hand corner of the Viewer window.

**Note:** If the Send Ctrl-Alt-Del feature is not functioning on a host PC with Vista or Windows 7 then the Secure Attention Sequence (SAS) may be disabled. Please see [Enable GoToMyPC to Send Ctrl-Alt-Delete on Vista and Windows 7](#) for more information.

  3. From the Windows Security screen click the **Lock Computer** button. Your computer workstation is now locked.

▸ *To lock Windows XP Home (or XP Professional with Fast User Switching)*
  1. Complete all activities on your host PC.
  2. Click the Windows **Start** button.
  3. Select **Log Off**.
  4. Select **Switch User**.
     Your computer workstation is now locked.

**Remotely Lock a Mac**

Since GoToMyPC can not be configured to automatically lock your Mac upon disconnection you should consider configuring your inactivity log out settings in the Security section of your Mac System Preferences.

▸ *To lock Mac OS X v10.5 or newer*
  1. Complete all activities on your host Mac.
  2. Click the **button at the top left of your screen.
  3. Select **Log Out** to securely lock your Mac.
**End Your GoToMyPC Connection**

Prior to disconnecting from your host Mac or PC, you may want to first lock your computer to help ensure your security. PC users can customize GoToMyPC on the Security tab in the Preferences window to automatically lock your host PC upon disconnection.

**Note:** If you are listening to music from your host PC, be sure to stop the music before disconnecting your session. If you do not stop the music on the host PC before disconnection, the music will no longer be muted and could be heard by anyone close to your host PC.

There are three ways to end your GoToMyPC connection.

▶ **To end your GoToMyPC connection from a PC**
  - From the Viewer menu bar, choose File, then Disconnect.
  - or -
  - In the upper-right corner of the Viewer window, click the button.
  - or -
  - Right-click the system tray icon and select End Session.

▶ **To end your GoToMyPC connection from a Mac**
  - From the GoToMyPC Viewer menu, choose Quit and Disconnect.
  - or -
  - In the upper-left corner of the Viewer window click the button.
The GoToMyPC Viewer

**Viewer Window and Host Image**

**The Viewer Window**
While in a remote session, the Viewer is displayed on your client computer (a) so that you can view a real-time image (c) of your host Mac or PC’s desktop. The Viewer (b) has a menu bar with options that allow you resize the host image and access features.
**Resize Your Viewer Window**

You can choose to have the viewer appear as a window on your desktop or as a full-screen image.

- **In Window mode**: The Viewer appears as a window on your desktop just like any other application. The Viewer menu and the Windows controls in the upper-right corner of your screen are always available and you can resize the Viewer window just like any other application window.

- **In Full Screen mode**: The Viewer expands to fill your entire screen and hides the GoToMyPC menu at the top of the screen. When you need to access the hidden menu from a Mac, move your mouse pointer to the top of the screen to display the menu. From a PC, simply select the menu tab at the top of the screen.

#### To start Full Screen mode

- From the Viewer window menu bar, select **View**, then **Full Screen**. This expands the Viewer window to Full Screen.

#### To end Full Screen mode

1. Move your mouse over the **menu tab** at the top of the screen to display the menu.
2. Select **View**, then **Window**. This will cancel the selection of Full Screen mode and return you to a resizable Viewer window.

**Note**: This if for the GoToMyPC Viewer window. For directions on other viewers, please see the [Universal Viewer](#) or [PocketView](#) Viewer sections.
**Resize Your Host Mac or PC Image**

You can choose to change the size of the image of your host desktop from the View menu at the top of your screen.

- **Actual Size**: Displays the actual image of the host desktop within the Viewer and may require you to scroll.
- **Scale to Fit**: Displays the image of the host desktop scaled to fit the whole desktop image within the Viewer.
- **Zoom To**: Allows you to zoom the image to a setting you choose. You can choose from several pre-set options or choose a custom option. This selection may require you to scroll.

*Note:* This is for the GoToMyPC Viewer window. For directions on other viewers, please see the Universal Viewer or PocketView Viewer sections.

**The Mac Slider Bar**

If you are viewing your host from a Mac, then you can also manage the size and screen mode directly from the slider bar at the bottom right of the Viewer window. To view the host desktop in Full Screen mode, simply click the button to the left of the slider bar.
**Multi-Monitor Support**

GoToMyPC supports multiple monitors connected to a single Mac or PC. You can choose which monitors to access while in session.

**Note:** Since GoToMyPC does not require the display monitors on your host Mac or PC, you may want to turn them off before you leave for privacy and to conserve energy. You can also set your monitors to automatically power down after a specified time in your PC's Display Properties control panel. Keep in mind that a host Mac or PC is not accessible while in sleep mode. See [Leaving your Host Accessible](#) for more information.

**Manage Multiple-Monitors from a PC Client**

**Note:** Hardware limitations may prevent host PC screen blanking from working with multiple monitors using a single video card. For optimal privacy it is advisable to turn both monitors off when not in use.

### Connecting to a multi-monitor host PC

1. Log in and connect to your host PC. The default screen shown will be your primary monitor.
2. To select another monitor, simply click the arrow button located on either side of the Viewer window.

   You can also click the <Windows> key on your keyboard and either the left or right arrow key depending on the orientation of your monitors.

   **Note:** For the <Windows> + arrow keys function to work, “Pass Windows keys to host computer” must be unchecked on the Viewer preferences.

3. To view all host PC monitors, hold the <Shift> key while selecting **Scale to Fit** mode from the View menu.

### Connecting to a multi-monitor host PC with a multi-monitor client PC

1. Log in and connect to your host PC.
2. Change to full screen mode to view both monitors by holding the <Shift> key and clicking the maximize/minimize window button on the top right of the Viewer; or hold the <Shift> key and select **Full Screen** from the View menu.

3. To toggle back to window mode, simply click the maximize/minimize window button in the viewer.

**Manage Multiple-Monitors from a Mac Client**

From a Mac, you can navigate between PC or Mac monitors by simply moving your mouse cursor to the corners of the screen. This will scroll the host image over to the second monitor. The **Scale to Fit** mode will display both monitors within the Viewer window.

**Note:** The screen blanking feature is not available on either Mac monitor, so for optimal privacy, it is advisable to turn off the Mac host monitor while not attended.

**Note:** The Internet connection is disabled when a Mac laptop lid is closed which will prevent you from remotely accessing the Mac laptop. See [Leaving your Host Accessible](#) for more information.
**Minimap**

The Minimap feature offers quick navigation between different monitors by displaying a scaled down version of the host computer.

This feature is not available for Mac computers.

To navigate between monitors with Minimap window

1. With the Viewer window selected, press and hold the `<Ctrl>` `<Windows>` keys on your keyboard and then left-click the mouse button to display the Minimap window.
2. Continue to hold the mouse button down while dragging the red navigation box to another section of the host desktop.
3. Release the mouse button to close the Minimap window.
Universal Viewer

The Universal Viewer enables you to view your host PC from any computing device and operating system that supports Java, including Mac, Linux and Solaris computers or from Windows computers that do not accept downloadable files. Please see System Requirements for more information on which systems may require the Universal Viewer.

This feature is particularly useful if you are using an Internet kiosk. To help ensure the greatest possible usability, the Universal Viewer has a limited set of features and does not include support for Sound, Chat, Clipboard, Remote Printing, File Transfer/Sync or Drag-and-Drop File Transfer or Viewer Dimming.

There is nothing you need to do to enable the Universal Viewer. It will automatically appear during the connection process if you are using an operating system other than the supported Windows or Mac operating systems, or if you are using a PC or Mac that does not accept downloadable files.

To help ensure your security when using the Universal Viewer, you are logged out of your GoToMyPC session any time you navigate to a new Web page, exceed your Viewer inactivity time-out period without any keyboard or mouse activity, or upon disconnection.

To begin a session with the Universal Viewer

1. Open a browser window and go to www.gotomypc.com.
2. Enter your email address and account password and click the Log In button.
3. If prompted, choose the account you want to access and click Go (only applies if you have multiple accounts associated with one email address).
4. To the right of the nickname of the PC to which you want to connect, click the Connect button.
5. On the connection status page, click the Use the Universal Viewer link.
6. The Universal Viewer should load in about 30 seconds.
Universal Viewer Shortcut
The Shortcut feature adds a shortcut to the client computer’s browser’s Favorites or Bookmarks folder. The Shortcut is convenient for users who frequently use the same client computer to access the same host PC (e.g. access a work PC from a home computer). The shortcut saves time by directing you to the Enter Access Code window, bypassing the usual browser/password login page.

To create a shortcut from the Universal Viewer
1. Begin a session as described above.
2. From the Universal Viewer window, choose File, then Create Shortcut to "Host PC Name".
3. Click Yes to authorize creation of a shortcut.
4. Select a location in your browser’s favorites folder and click OK.

Note: If your browser does not support creating bookmarks automatically, a link will be provided that can be pasted into a bookmark. Simply create a bookmark from your browser and then right-click the new bookmark and select Properties. Replace the existing bookmark link with the provided link.

Resize Your Host Computer Image
You can choose to change the size of the image of your host desktop within the Universal Viewer. You have the options of choosing to adjust your image size to Actual Size, Scale to Fit or Zoom To from the View menu.

- Actual Size: Displays the actual image of the host computer desktop within the Universal Viewer and may require you to scroll.
- Scale to Fit: Displays the image of the host computer desktop scaled to fit the whole desktop image within the Universal Viewer.
- Zoom To: Allows you to zoom the image to a setting you choose. You can choose from several pre-set options or choose a custom option. This selection may require you to scroll.

Lock and Unlock your Host PC with Send Ctrl-Alt-Del
The Send Ctrl-Alt-Del feature can be used to unlock and lock a host computer. For more information please see the sections titled Remotely Unlock Your Host PC and Remotely Lock Your Host PC.
**PocketView™**

GoToMyPC PocketView enables you to securely access your host Mac or PC from your compatible handheld device. GoToMyPC PocketView includes support for use of a stylus, scrolling, scaling, and portrait or landscape orientation.

To help ensure the greatest possible usability, GoToMyPC PocketView does not include Sound, Chat, Remote Printing and File Transfer/Sync.

There is nothing you need to do to enable GoToMyPC PocketView. It will be automatically selected during the connection process if you are using a device with a supported operating system to connect to your host computer.

**Note:** To use GoToMyPC PocketView, see System Requirements. Please note that performance will depend on the speed of the device’s connection to the Internet.

**Note:** PocketView is not available for Blackberry or iPhone.

**Accessing Your Host Mac or PC Using PocketView**

When accessing your host computer using a PocketView compatible device, follow the same procedure that is outlined for use with a desktop computer.

1. From the Web browser on your handheld, enter www.gotomypc.com.
2. Enter your email address and account password and click Log In.
3. PocketView users will need to click the Download link to begin. Select the checkbox to open the file after download. Overwrite the file if it already exists. Click Yes.
4. When prompted, enter the host computer's access code and click OK.
5. The host computer image will appear in the PocketView window.
6. Congratulations! You are now connected to your host Mac or PC and are ready to start accessing all your files, applications and email as if you were sitting at your computer!
The PocketView Toolbar and Menu

The PocketView Toolbar
The toolbar appears at the top of the handheld device and enables you to quickly access common PocketView features.

The PocketView Menu
To display the menu, tap the Menu option on the PocketView toolbar.

- **To adjust host computer image size**
  - From the View menu, use the Actual Size, Scale to Fit or Zoom To settings

- **To adjust host computer image orientation**
  - From the View menu, use the No Rotation, Rotate Left or Rotate Right settings
To access PocketView tools

- Use the Tools menu to access Send Ctrl-Alt-Del, Preferences and PocketView Preferences
**PocketView Preferences**

In addition to the standard GoToMyPC Preferences, PocketView has some per-device settings in its PocketView Preferences dialog. These settings always take precedence over any settings in the general GoToMyPC Preferences.

- **Initial size:** The initial size may be set to Actual Size or Scale to Fit or it can start in Jump-Navigate mode in which the first tap will zoom to that point in Actual Size.
- **Initial rotation:** The initial rotation may be set to No Rotation, Rotate Left or Rotate Right.
- **Force 256 Colors (requires reconnect):** Overrides host PC Color Quality preference set for True Color for improved performance.
- **Large toolbar:** Increases the size of the toolbar.
- **Auto-hide toolbar:** Hides the toolbar after each action.

![PocketView Preferences](image)
Using PocketView

❖ To quickly scroll to another area on your desktop
  1. Tap the Jump-Navigation button on the toolbar to temporarily put the Viewer into
     fit-to-screen mode so you can easily see your entire desktop.
  2. Click the part of the screen where you wish to scroll to and you will be returned to
     your previous zoom level, but centered at the location where you clicked.

❖ To scroll host computer image
  • Tap and hold the stylus on the edge of the screen to scroll in that direction. Scrolling
    will stop when the stylus is released. When dragging a selection on the host computer,
    if you drag the stylus to the edge of the screen, PocketView will automatically begin
    scrolling so that you can select non-visible areas of the host screen.

❖ To right-click
  1. Tap the right-click mode button and the next tap will be a right-click.
  2. Or you can use the tap-and-hold gesture to perform a right-click (not all devices
     support this).

❖ To move the cursor without left-clicking
  • Tap the hover mode button and the next tap will only move the cursor.

❖ To change the soft input panel
  • Tap, hold and release the on-screen keyboard button to choose an input panel.

❖ To create a shortcut to your host computer
  • Choose File from the PocketView menu, then Create Shortcut (not all devices
    support this). The shortcut will be added to your Programs folder.

❖ To disconnect a PocketView session
  • Choose File from the PocketView menu, then Disconnect.

❖ To restore PocketView (Pocket PC and Windows Mobile devices only)
  • To restore PocketView after minimizing it, choose Start, then Programs and then
    GoToMyPC PocketView.

Note: See the GoToMyPC Features section for more information.
**PocketView Usage Recommendations**

Choose a device that is appropriate for you:

1. A Pocket PC, Windows Mobile, or Windows CE device with WiFi provides the fastest access.
2. A Pocket PC Phone Edition or Windows Mobile Phone Edition device provides access over the largest geographical area.
3. An external or built-in keyboard is recommended if you enter text often.
4. A Windows Mobile device with a high resolution (VGA) screen is recommended for easiest viewing.

**Note:** To use GoToMyPC PocketView, see System Requirements. Please note that performance will depend on the speed of the device’s connection to the Internet.

**Note:** PocketView is not available for Blackberry or iPhone.

Optimize your PocketView experience:

1. On a PC host, right-click the GoToMyPC icon on your host computer and select Preferences. Under the Host tab, turn on the following option:
   - Automatically adjust the host computer’s screen area
2. From the Tools menu in PocketView, select PocketView Preferences:
   - Show the host computer’s cursor
   - Adjust the other settings to your liking
3. From the View menu in PocketView:
   - Set the Zoom to 75%
   - Select Rotate Left or Rotate Right
4. From the File menu in PocketView:
   - Create a Desktop Shortcut to your host computer
Using GoToMyPC Features

GoToMyPC comes with a complete set of features to help you get the most out of remotely accessing your Mac or PC. Listed below are several of the main features you’ll want to try. Most of the features are accessible through the Viewer. PC users can access additional features from the icon in the Windows system tray, which is usually located in the lower-right corner of your screen near the clock.

**Note:** If you are a GoToMyPC Corporate user, your ability to access features may be disabled by your administrator. If you are unable to access a feature, please contact your administrator for further details.

Some features are incompatible with some operating systems. Significant differences in how GoToMyPC works on a Mac platform are highlighted with this icon. For a comparison between Mac and PC please see Mac Features.
**Mac Features and Keyboard Mapping**

**Feature Comparison between Mac and PC**
Listed below is a side-by-side comparison on the features currently available for Macs and PCs.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Mac Support</th>
<th>PC Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Sharing</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>End-to-end 128 bit AES encryption</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>User Authentication</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Inactivity Timeout</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Keyboard Locking &amp; Screen Blanking</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Cut, Copy and Paste</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>File Transfer &amp; File Sync</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Guest Invite</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Reporting</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Remote Printing</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>PocketView Wireless Access</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Sound</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Web Shortcut</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Desktop Shortcut</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi-Monitor Support</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>24/7 Global Customer Support</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Shared Access (GoToMyPC Corporate)</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Signature Protocol (GoToMyPC Corporate)</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>RADIUS/SecurID (GoToMyPC Corporate)</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Host/Client Authorization (GoToMyPC Corporate)</td>
<td>Host only</td>
<td>Yes</td>
</tr>
<tr>
<td>One-Time Passwords</td>
<td>Viewer Only</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Keyboard Mapping**
Currently the following keys are considered equivalent.

<table>
<thead>
<tr>
<th>Mac</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option/Alt</td>
<td>Alt</td>
</tr>
<tr>
<td>Command (Apple)</td>
<td>Windows</td>
</tr>
<tr>
<td>Clear</td>
<td>Num Lock</td>
</tr>
<tr>
<td>Control</td>
<td>Ctrl</td>
</tr>
</tbody>
</table>

Here is an example of a common keyboard activity:

<table>
<thead>
<tr>
<th>Desired Operation</th>
<th>Viewer Type (client)</th>
<th>Host Type</th>
<th>Keyboard Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Mac</td>
<td>Window</td>
<td>Control key+ c</td>
</tr>
<tr>
<td>Copy</td>
<td>Windows</td>
<td>Mac</td>
<td>Windows key+ c</td>
</tr>
</tbody>
</table>
**Right-Click from a Mac Client**

To right-click an item on a host PC from a Mac client use the <Shift> + <Ctrl> + mouse click. You can also select the **Set Right-click** button in the Mac Viewer to set your next mouse click to be a PC right-click.

![Set Right-click](image)

**Remote Printing**

With the Remote Printing feature PC users can easily print remote files to the local printer. No need to transfer files before printing or worrying if the correct application is installed on the local computer.

This feature is not available for Mac computers.

There are two ways to print:

- **GoToMyPC Printer**: Simply select the *GoToMyPC Printer* option from the *Print* window and print as you normally would. Without doing anything else your file will print to your local computer's default printer.
- **Manually Enable a Local Printer**: Printing with the *GoToMyPC Printer* is recommended for most jobs but there may be situations (e.g., printing checks or other cases where precision is required) where you may want to manually enable a specific printer. This process requires that you first set up your local printer on the remote computer while in a remote session.
GoToMyPC Printer

When you remotely connect to your host PC, the GoToMyPC Printer feature automatically detects the printers available to your client computer. By selecting the GoToMyPC Printer from the Print window, you are directing the print job to your local default printer.

To print a remote file to your local printer

1. Open your file on the remote PC and select Print from your application’s File menu.
2. Verify that the GoToMyPC Printer is selected in the Print window.
3. Click OK to print to your local computer’s default printer. That’s all there is to it!

Print to a Different Local Printer

You can easily switch between your local printers while in a remote session.

To switch local printers

1. While in a remote session, select the File menu from the top of your GoToMyPC viewer, then Select GoToMyPC Printer.
2. GoToMyPC provides a list all the local printers that have already been enabled on your client computer. Select the local printer that you want to use. Congratulations - you’ve just told GoToMyPC where to print your files!
3. Now you’re ready to print to the new local printer. Return to the file in the remote application and print with the GoToMyPC Printer as explained above.
Manually Enable a Printer

By manually enabling your local printer to work with GoToMyPC you will get the best possible print results. There are a few extra steps required to properly configure a remote PC to work with your local printer but this only needs to be done the first time. If the highest level of color and print accuracy aren't critical to your project then we recommend you use the GoToMyPC Printer for convenience.

Before you Begin: Some printers require a host PC reboot upon setup so before you begin make sure that GoToMyPC is configured to load automatically after a reboot. This can easily be confirmed from the GoToMyPC startup preferences. Right-click the icon in the system tray, which is found at the bottom right of your remote desktop, and select Preferences. From the Host tab make sure Start GoToMyPC: Automatically is selected.

Note: The add printer wizard will not be able to detect the type of printer if you attempt to install the printer from the system tray icon while you are not in session. The process of installing a remote printer will vary depending upon operating system and access to printer drivers. If you do not have the necessary printer driver on your host PC, you may need to download the driver from the manufacturer's Web site before you can complete the installation of a remote printer.

To manually install a local printer while remotely connected

1. Start a remote session and connect to your host PC from the computer that you want to print from.
2. Once connected, right-click the icon in the system tray of your remote desktop and select Preferences.
3. Select the Printing tab and then click Add Printer.
4. On the Select a Printer to Set Up screen, the drop-down menu will automatically select the default printer (from your Printers folder) installed on your local client computer. If you wish to select another printer, click the drop-down menu and choose the printer you want to set up. Click OK. GoToMyPC will search for available printer drivers.

5. The Add Printer Wizard screen opens. Notice the GoToMyPC Printer Setup Instructions Tips window attached to the left of the Add Printer Wizard screen. Please pay particularly attention to this menu during the setup process; it will provide assistance in setting up the local printer. Click Next.

   **Note:** The install process varies from one manufacturer to another, so please follow the instructions from the manufacturer in full to install the driver. Some manufacturers will require communication with your printer. In such cases, please click cancel when the installer reports that printer is not attached. Due to variations in installation the following instructions are intended as a general guide only.

6. On the Local or Network Printer screen, select Local printer. Make sure that Plug and Play auto-detection is NOT selected. Click Next.

7. On the Select the Printer Port screen, scroll down and select the GoToPort. Click Next.

8. On the Install Printer Software screen, select the manufacturer and model of your printer. Click Next.

   **Note:** Start by selecting the manufacturer and then select the printer model that is closest to the model you have. If you cannot find a close match, you may need to download the driver from the manufacturer’s Web site. Once you have downloaded the driver (be sure it is the correct driver for your host PC operating system), click the Have Disk button, browse to where you downloaded the driver, select the driver and click OK. See Locate and Install a Printer Driver on the Host PC for more information.

9. On the Name Your Printer page, enter the name for this printer. We recommend that you keep the "GoToMyPC" preface to the printer name to help you identify the printer in the future. Select No if asked to set this printer as the default printer. Click Next.

10. On the Printer Sharing screen, select Do not share this printer. Click Next.

11. On the Print Test screen, select Yes if you are remotely connected; select No if not. Click Next. Click Finish.

   **Note:** If your host PC operating system is Windows 2000, XP, Vista or Windows 7 and you wish to manually enable a printer, please ensure that you have administrator rights when you upgrade/install GoToMyPC.
Locate and Install a Printer Driver on the Host Computer

To Locate and install a printer driver on the host computer

1. If the printer driver is not available, it will need to be downloaded from the manufacturer's Web site (e.g. www.hp.com, www.canon.com or www.brother.com.)
2. From a browser on your remote computer, navigate to the manufacturer's Web site and start your search for the printer driver. Print drivers are most commonly found on the Support or Service sections. It will vary, so if you have a hard time finding it, please contact their support for assistance.
3. Once the local print driver has been downloaded to your remote PC, you are ready to add the printer to GoToMyPC's list of printers. Please continue to the previous set of instructions titled **Manually install a local printer while remotely connected**.
**File Transfer**

File transfer enables PC users to quickly and easily transfer files between the host and client. You can use the File Transfer feature or you can drag and drop files simply by clicking on a file and dragging it between computers.

This feature is not available for Mac computers.

▶ **To transfer files between the local and remote computer**

1. From the Viewer menu bar, select **Tools**, then **Transfer or Sync Files**.

Or you can click the **File Transfer** shortcut in the upper right-hand corner of the viewer window.

The **File Transfer** window opens. The files on your remote computer (Host) are displayed on the left pane and files from your local computer (Client) are displayed on the right.
2. For the destination computer, browse to and open the folder to store the transferred files.
3. For the source computer, browse to and select the file or folder you wish to transfer and either click the Transfer button or drag-and-drop the desired files to the destination computer.

**Drag and Drop Files between PCs**

> **To drag and drop files**
> - To drag and drop files directly between your host and client simply drag a file or folder from the Viewer window to your local computer (or the other way around) to start copying.

**Note:** If you are having difficulty finding the files to send, or finding the files you sent, this is likely due to the use of a user profile, which most often occurs with Windows 2000. To transfer desktop files stored in your profile or to find files you transferred to your desktop, you will need to look for the appropriate folder within your user profile. Windows 2000 users: go to C: Documents and Settings, then Your User Name, then Desktop.

**Note:** If you are having difficulty transferring files from Windows Vista or Windows 7, it could be that you are attempting to transfer files from a folder that requires privilege elevation. To transfer these files, first transfer them to a folder you have permission to write to, then move them to their final destination using Windows Explorer.
**File Sync**

The File Sync feature enables PC users to easily synchronize folder contents between the host and client while in-session. Since File Sync is bi-directional, files are transferred in either direction until both sides match. When files with the same name exist on both ends, you have the option to copy the newer file, copy the older file or skip the file.

This feature is not available for Mac computers.

**To synchronize folders**

1. From the Viewer menu bar, choose **Tools**, then **Transfer or Sync Files**.

   Or you can click the **File Transfer** button in the upper right-hand corner of the Viewer window.

   The File Transfer and Sync window opens. The host files are in the left pane, the client files on the right.

2. Double-click the folder you want to sync on the host so that the contents are displayed in the left pane.
3. Next, double-click the corresponding folder you want to sync on the client so that the contents are displayed in the right pane.
4. Click the **Sync Views** button from the File Transfer and Sync window.
5. From the **Sync Confirmation** window, indicate how you prefer GoToMyPC to handle different files with the same name.
6. Click **Continue** to begin synchronization.
Repeat a Recent File Sync

Select the Repeat a Recent File Sync shortcut to save the step of navigating to the individual folders on your host and client computer. This feature displays a selectable list of the last three syncs for quick execution.

To repeat a recent file sync

1. From the Viewer menu bar, choose Tools and then Repeat a Recent File Sync.
2. Select a folder pair from one of the three most recent file syncs.
3. Confirm the folder locations and indicate how you prefer GoToMyPC to handle different files with the same name.
4. Click Continue to begin synchronization.
**Remote Sound**

The Remote Sound feature allows PC users to enjoy audio from their remote host PC. The sound settings can be optimized for system sounds or music depending on your sound card, personal preferences and the speed of your network connection.

Temporary adjustments to your in-session sound settings can be made directly from the Viewer window. Adjustments can also be made from [Audio Preferences](#).

This feature is not available for Mac computers.

**To modify your sound preferences**

1. Click the *Sound* button in the upper right-hand corner of the Viewer window.
2. Select Sound Settings from the menu.
3. From the *Sound* tab modify your sound settings and click *OK*.
Sound Features

- **When my session starts:** Select your preferred sound settings on startup. Select the *Turn off Sound* option for optimal system performance. If you intend to listen to music, select *Use High Quality Sound*.
- **Sound options:** Select your preferred audio source or let GoToMyPC detect the source automatically. If desired, GoToMyPC can automatically disable the Sound feature if a slow network connection is detected. For in-session privacy, leave the "Mute speakers on the host PC while in session" option selected.

When selected, GoToMyPC records sound from the Windows default recording device without changing the active input or volume level. If these inputs are not configured correctly the sound may not work or have poor quality.

Please see the [Troubleshooting Sound Issues](#) section for more information on the Remote Sound feature.

![Preferences - GoToMyPC](image)

**Note:** If you are listening to music from your host PC, be sure to stop the music before disconnecting your session. If you do not stop the music on the host PC before disconnection, the music will no longer be muted and could be heard by anyone close to your host PC.

**Note:** For optimal music quality, install the latest approved Windows Media Player on both the host PC and client PC.

**Note:** The High Quality Sound option is currently not available on Microsoft Vista or Windows 7. Sound is not available with the Universal Viewer or PocketView.

**Note:** GoToMyPC software may be used to access materials on a remote computer. It is licensed to you only for access to remote computers which you are authorized to access or make use of, and for access to non-copyrighted materials, materials in which you own the copyright, or materials you are authorized or legally permitted to access. If you are uncertain about your right to access any material you should contact your legal advisor.
Session Performance

While remotely connected to your PC, you can review your session performance and tips for improving the performance.

This feature is not available for Mac computers.

Note: GoToMyPC will automatically disable Vista’s Aero Glass Windows theme to maintain optimal performance.

To view your session performance from PC

1. In the GoToMyPC Viewer window, click Help in the top menu.
2. Select Session Performance.
3. Your session performance will be displayed for the host PC to which you are currently connected.
**Guest Invite**

The Guest Invite feature enables PC users to invite other PC users to view the desktop of your host while he or she is physically present at the host PC.

The Guest Invite feature is only available from PC to PC.

---

**To invite a guest to your host PC**

1. Right-click the system tray icon and select **Invite Guest to PC**.
2. When prompted, type in the email address of the guest you want to invite. Or you can select an email from a list of recently invited guests by clicking the drop-down menu.
3. Add to or customize the message that will be sent to your guest (optional).
4. From the drop-down menu, select the time when the invitation will expire.
5. Click **Send**.

![Guest Invite dialog box](image)

6. When prompted, enter the email address and password you use to log in to GoToMyPC.
7. Click **OK**.
8. Your invitation is sent to your guest, who will receive it via email. Click **OK** to close the send notification.

**Note:** You must be at your host PC to invite a guest to connect to it. After you send an invitation, you can check the time left on the invitation or cancel it by right-clicking the system tray icon and selecting Guest Invited. Invited guests will not be able to accept invitations from the Mac Viewer.
**Connect to an Invited Guest**
To accept the invitation, your guest will need to click the activation link included in the invitation email. If your guest accepts within the time you allotted, you receive a Guest Arrived notice.

▶ **To connect with the guest on your host PC**
1. In the Guest Arrived window, select the corresponding check box to give your guest view-only access or full remote-control access to your computer.
2. Uncheck the Sound box if you do not want your guest to hear the sound on your PC.
3. Click **OK**.

A chat box will appear on your desktop and your guest will be able to view your desktop with a Viewer window on his or her desktop.
Change Guest Access
You may change your guest’s access or disconnect the session at any time.

To modify guest access from your host PC
1. Right-click the system tray icon and select Guest Connected.
2. Select the desired level of access or disconnect the session.

Chat
Chat is a function that enables you to communicate with a guest you have invited to your computer. To communicate with Chat, simply enter your text into the text entry field and click Send or press the Enter key on your keyboard. The chat dialog is automatically displayed once your guest is connected.

To open a Chat dialog
- From the Viewer window menu bar, select Tools, then Chat. The chat box will appear on both the host PC and client computer.

To end Chat
- From both the host and client chat box, simply close the box by clicking in the upper-right corner of the chat dialog.
**Drawing Tools in Guest Session**

The Drawing Tools feature enables you and your guest to use a mouse to draw or highlight on the screen for greater communication.

*Note:* The Drawing Tools feature is only accessible while connected to a guest.

▶ **To use a drawing tool**

1. To access the drawings tools from the guest’s Viewer window, choose **Tools**, then **Drawing Tools**. Or the guest can click the **Drawing Tools** button in the upper right-hand corner of the Viewer window.

![Drawing Tools Menu]

To access the drawing tools from the host PC, right-click the 

icon in the system tray and select **Drawing Tools**.

2. Select the desired tool and click and drag to draw on the screen.

▶ **To erase Drawings**

- With one of the drawing tools enabled, right-click the screen and select **Erase All Drawings**.
  
  This will erase your drawings but keep you in the drawing mode.

▶ **To end Draw**

- Press the <Escape> key or right-click the screen and select **Mouse Pointer** from the Drawing Tools menu to exit the drawing mode.

*Note:* If you are a GoToMyPC Corporate account user, your ability to access features may be disabled by your GoToMyPC account administrator. If you are unable to access a feature, please contact your account administrator for further details.
Cut/Copy and Paste

The cut/copy and paste feature enables you to cut/copy and paste text between the host Mac or PC and client computer.

To cut/copy and paste text

1. Select the text you want to cut or copy by left-clicking you mouse and dragging the cursor over the text.
2. Right-click your mouse on the selected text and choose Cut or Copy.
3. Place your mouse in the location where you want to paste the text and left-click your mouse.
4. Right-click your mouse and select Paste.

Note: The Cut, Copy and Paste feature has a text-only maximum of 32kb of data.

Mac and PC clipboards are compatible during your remote sessions so you can always use your favorite application's built-in cut/copy and paste commands to manage text. If you prefer keyboard commands then some substitutions are required due to differences between the Mac and PC keyboards. See Mac Features and Keyboard Mapping for more information.

<table>
<thead>
<tr>
<th>Keyboard Shortcut Substitutions (copy example)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td>Mac Client</td>
</tr>
<tr>
<td>PC Client</td>
</tr>
</tbody>
</table>
**Desktop Shortcut**

The Desktop Shortcut feature adds a shortcut to your desktop that enables fast and easy access to your host Mac or PC. This feature is convenient for users who frequently use the same client computer to access the same host Mac or PC (e.g. access a work PC from a home computer). The shortcut saves time by directing you to the *Enter Access Code* window, bypassing the usual browser/password login page.

**Create a Shortcut on a PC**

To create a desktop shortcut from a client PC

1. Log in and remotely connect to your host Mac or PC from the client PC on which you want to create the desktop shortcut.
2. From the client computer Viewer window, choose **File**, then **Create Shortcut to "Host Computer Name"**.
3. Click **Yes** to authorize creation of a desktop shortcut.
4. Enter your account password and click **Continue**.
5. Click **OK**.

A desktop shortcut will be created on your client computer desktop.

**Note:** The first time you use a shortcut from a client computer, you will be required to authenticate your account by entering your email address and password. If this first-time log in is successful, subsequent uses of Desktop Shortcut on the client computer will not require authentication.

**Note:** The Create Shortcut option on the File menu will not be visible when a guest is connected to your PC during a Guest Invite session so that guests cannot create shortcuts from their computers to yours.

**Note:** You can revoke all shortcuts associated with your host Mac or PC by clicking the **Options** link on the My Computers page.

**Note:** The desktop shortcut can be copied or moved to another location on your client computer but not to another Mac or PC.

**Access a Host with a Desktop Shortcut**

To access a computer using a desktop shortcut

1. From the desktop of the client computer, double-click the GoToMyPC shortcut icon.
2. When prompted, enter the access code for your host PC.

The GoToMyPC connection will begin.
Revoke All Desktop Shortcuts

To revoke all desktop shortcuts to your host Mac or PC

1. Log in to www.gotomypc.com and view the My Computers page.
2. Click the Options link to edit the host Mac or PC you wish revoke all desktop shortcuts.
3. Next click the Revoke button; this will invalidate all shortcuts to your host computer.

Note: If you are a GoToMyPC Corporate account user, your ability to access features may be disabled by your GoToMyPC account administrator. If you are unable to access a feature, please contact your account administrator for further details.

Create a Web Shortcut on a Mac

1. From your Mac client, enter your email address and account password at www.gotomypc.com and click Log In.
2. Select Options next to the host nickname on the My Computers screen.
3. Click the Shortcut button under Computer Info to create a shortcut or bookmark in your browser.

Create a Desktop Shortcut on a Mac

To create a desktop alias from a Mac client

1. From your Mac client, enter your email address and account password at www.gotomypc.com and click Log In.
2. Select Options next to the host nickname on the My Computers screen.
3. Click the Shortcut button under Computer Info to display the shortcut URL.
4. Select and copy (from your keyboard, \t c \t) the newly created URL.

5. Now that you have the URL copied to your clipboard, it needs to be pasted into a bookmark in your browser. In the Safari menu bar, select Add Bookmark from the Bookmarks menu and then click Add to confirm.
6. Next, select Show All Bookmarks from the Bookmarks menu.
7. Select the address next to the newly created bookmark and then paste (from your keyboard, \t v \t) your host’s URL.

Tip: To replace the bookmark’s URL first click the URL, wait a few seconds and then click the URL a second time. This allows you to edit the URL.
8. Drag the newly created desktop shortcut to your desktop for easy access.
9. Double-click the newly created shortcut and click **Open** at the browser security prompt.
10. The first time you access your newly created alias you are prompted to enter your account password. This is the same password you used to log in to the [www.gotomypc.com](http://www.gotomypc.com) site. Subsequent visits will only require your access code which will allow you to bypass the [www.gotomypc.com](http://www.gotomypc.com) page and save you time.
Reconnect

GoToMyPC warns you if a session is about to be disconnected due to inactivity. If prompted, simply click Keep Active to keep the session active; otherwise, click the Disconnect Now button to end the session.

If your session times-out, you are given an option to begin a new session by clicking Reconnect from the Inactivity window. If you used the Desktop Shortcut feature to begin the session, you are quickly directed to the Enter Access Code window. PC users can modify your time-out setting in Security Preferences.

This feature is not available to Mac users.
**Remember Me**

The Remember Me feature provides a fast and easy alternative to accessing your GoToMyPC account. By setting a cookie on a trusted computer your browser will bypass the login screen and send you directly to the *My Computers* screen. From this page you can manage your account settings and start a GoToMyPC session. You are still prompted for your computer's access code.

For security reasons do not use this feature on a shared or public computer.

> **To enable Remember Me**

1. From the host Mac or PC on which you want to activate the Remember Me feature - log in to your GoToMyPC account.
2. Click the *My Account* link in the left navigation bar.
3. Enter your current password to make changes.
4. Select the check box for *Remember Me*.
5. Click *Save Changes*.

**Note:** Use of the Remember Me feature requires that cookies be enabled for your browser (please see your browser's Help for directions on how to enable cookies). To use the Remember Me feature, you must close your browser by clicking in the upper-right corner of the browser window, or by choosing File then selecting Close from the menu bar. The Remember Me feature will NOT work if you click the Log Out link in the left navigation bar.
Disable Remember Me

To disable Remember Me
  1. From the client Mac or PC on which you want to activate the Remember Me feature - log in to your GoToMyPC account.
  2. Click the My Account link in the left navigation bar.
  3. Uncheck the Remember Me check box to clear.
  4. Enter your current password to make changes.
  5. Click Save Changes.

Note: If you are a GoToMyPC Corporate account user, your ability to access features may be disabled by your GoToMyPC account administrator. If you are unable to access a feature, please contact your account administrator for further details.
View Access Activity Report

The Access Activity Report feature enables you to view your account’s connections for a selected day. The report will tell you the source of the connection, the time it occurred, the client IP, the type of access and the duration of the connection.

Note: GoToMyPC Corporate and GoToMyPC Pro administrators can run Activity Detail reports for a selected date range.

To view the Access Activity report:
1. Log in to your GoToMyPC account at www.gotomypc.com.
2. Click the My Computers link in the left menu bar.
3. Click the Access Activity link in the left menu bar.
4. Select the desired date for the access activity.
5. Click the View Access Activity button.
One-Time Passwords

The use of One-Time Passwords (OTPs) offers an additional level of security that can protect you while you are using public terminals that may have keyboard loggers or other keystroke-capture hardware or software. Our One-Time Passwords system ensures that a discovered password is useless to the person who discovers it.

One-Time Passwords are composed of six words, and each six-word combination provides one-time access to a host PC. Password lists are numbered in reverse order from highest to lowest and end in zero.

The use of One-Time Passwords enables you to generate a list of One-Time Passwords that you will be prompted to enter after you enter your access code each time you access your host PC.

Note: Your administrator may require that you use One-Time Passwords. The One-Time Passwords feature cannot be used in conjunction with the Share Access feature.

Mac users can access Host PCs with One-Time Passwords enabled. The One-Time Password feature is not currently available on Mac hosts.

To enable One-Time Passwords

1. While physically present at the host PC you want to enable for One-Time Passwords, right-click the system tray icon and choose Preferences.
2. Click the Authentication tab, then click the Enable OTPs button.
3. On the Generate One-Time Passwords dialog box, select the number of One-Time Passwords to generate (min. of 10, max. of 99) and click OK.
4. On the Enter Access Code dialog box, enter the access code for the host PC and click OK.
5. On the Print One-Time-Passwords List dialog box, select the font size to print and click the Print button.
6. Verify your list of One-Time Passwords has printed and click Close.
7. On the GoToMyPC Corporate Preferences dialog box, click OK.

You have now enabled use of One-Time Passwords on your host PC and you will be prompted to enter an OTP next time you access your host PC from a client computer.
To access your Host PC using One-Time Passwords

2. Enter your email address and account password and click Log In.
3. If prompted, choose the account you want to access and click Go (only applies if you have multiple accounts associated with one email address). This will load your My Computers page.
4. To the right of the computer Nickname, click the Connect button.
5. When prompted, Click Yes or Grant to download the GoToMyPC Viewer.
6. When prompted, enter the host PC’s Access Code and click OK.
7. When prompted, enter one of your six-word One-Time Passwords and click OK. The host PC image will appear in the Viewer window. You are now connected to your host PC and are ready to begin accessing all your files, applications and email as if you were sitting at your PC!

To generate a new list of One-Time Passwords

1. While physically present at, or connected to, the host PC for which you want to generate a new list of One-Time Passwords, right-click the system tray icon and choose Generate One-Time-Passwords.
2. On the Generate One-Time Passwords dialog box, select the number of One-Time Passwords to generate (min. of 10, max. of 99) and click OK.
3. On the Enter Access Code dialog box, enter the access code for the host PC and click OK.
4. On the Print One-Time-Passwords List dialog box, select the font size to print and click the Print button.
5. Verify that your list of One-Time Passwords has been printed and click Close.

Note: You can generate a new list of One-Time Passwords at any time while still have OTPs available. Should you use all your OTPs before generating a new list, you will have to return to your host PC to generate a new list or to disable One-Time Passwords.

To disable One-Time Passwords

1. While at the host PC for which you want to disable One-Time Passwords, right-click the system tray icon and choose Preferences.
2. Click the Authentication Tab.
3. Click the Disable OTPs button.
4. Click Yes on the warning dialog box that you want to disable One-Time Passwords.
5. On the Change Access Code dialog box:
   - Enter your old access code.
   - Enter your new access code.
   - Confirm your new access code.
   - Click OK.
6. On the GoToMyPC Corporate Preferences dialog box click OK.

Note: To help protect your security, you will be required to change your access code for your host PC anytime you disable the use of One-Time Passwords.
**In-Session Reboot (GoToMyPC Corporate Only)**

The In-Session Reboot feature enables you to remotely reboot your host computer and log back in with your Windows login credentials. This is an exclusive feature to accounts that have the Shared Access feature enabled. Since the In-Session Reboot feature is not a default setting, it must first be enabled by your administrator at the user or group level in the GoToMyPC Administration Center.

This feature is not available for Mac computers.
**Host Authorization (GoToMyPC Corporate only)**

If you are a GoToMyPC Corporate user, your administrator may require you to request authorization for your host PC before you can set up or access that host PC. Authorization requires that you send your host PC’s MAC address and C: Drive serial number to your administrator.

This feature is not available for Mac computers

▶ **To authorize your host PC for a new host PC installation:**

1. Upon completion of the GoToMyPC Corporate installation, you will be presented with an installation confirmation window that will also provide you with the MAC address and C: Drive serial number; copy the information and email it to your administrator. Your administrator will authorize your host PC and should notify you when authorization is complete.

▶ **To authorize your host PC for an existing host PC:**

1. While physically present at the host PC you want to authorize, right-click the icon in the system tray and choose Preferences.
2. Click the Host tab.
3. Click the Authorization ID button.
4. On the Host Authorization Identification dialog box, copy the MAC address and C: Drive serial number and email it to your administrator.
5. Your administrator will authorize your host PC and should notify you when authorization is complete.

**Client Authorization (GoToMyPC Corporate only)**

If you are a GoToMyPC Corporate user, your administrator may require you to request authorization for your client computer before you can use it to access your host PC. Authorization requires you to send your client computer’s MAC address and C: Drive serial number to your administrator.

▶ **To authorize a client computer:**

1. While at the client computer you want to authorize, access your GoToMyPC Corporate account and begin a connection to your host PC. Once the download process is completed and the Viewer window appears you will be notified that the client PC requires authorization. The notification dialog box will contain the client PC’s MAC address and C: Drive serial number; copy the MAC address and C: Drive serial number and email it to your administrator. Your administrator will authorize your client PC and should notify you when authorization is complete.

This feature is not available for Mac computers
RADIUS Integration (GoToMyPC Corporate only)

If you are a GoToMyPC Corporate user, your administrator may configure your GoToMyPC Corporate account to integrate with RADIUS.

RADIUS is a two-factor authentication method based on something you know (a password or PIN) and something you have (an authenticator), providing a more robust level of user authentication.

Use of RADIUS will prompt you to enter your RADIUS credential (PIN and tokeencode) after your access code each time you access the host PC.

**Note:** RADIUS Integration is only available if your administrator has required the use of RADIUS. This option will not appear to users who are not configured to use RADIUS.

This feature is not available for Mac computers

### To configure RADIUS on your host PC:

1. While at the host PC you want to enable for RADIUS, right-click the system tray icon and choose **Preferences**.
2. Click the **Authentication** tab.
3. Click the **Configure RADIUS** button.
4. On the Configure RADIUS dialog window, enter the RADIUS server name to the list by entering its hostname or IP address, then click **Add**.
5. Enter your RADIUS user name (name of the user in the RADIUS database).
6. Enter the **RADIUS encryption key** (provided by the system administrator).
7. Click the **Test Configuration** button.
8. When complete with configuration and testing, click **OK** to close the Configure RADIUS dialog box.
9. Click **OK** to close the GoToMyPC Corporate Preferences dialog box.

**Note:** Before you can configure your host PC with RADIUS, your administrator must enable you to view the option to configure RADIUS, which is located on your GoToMyPC Corporate Preferences menu. Your administrator may choose to configure your host PC for you.
To connect to your host PC with RADIUS:
2. Enter your email address and account password and click Log In.
3. If prompted, choose the account you want to access and click Go (only applies if you have multiple accounts associated with one email ID). This will load your My Computers page.
4. To the right of the Nickname of the PC to which you want to connect, click the Connect button.
5. When prompted, Click Yes or Grant to download the GoToMyPC Corporate Viewer.
6. When prompted, enter the host PC’s Access Code and your RADIUS credential (your PIN and token code from token) and click OK.
7. The host PC image will appear in the Viewer window.
   You are now connected to your host PC and ready to start accessing all your files, applications and email as if you were sitting at that computer!

Note: You cannot connect with RADIUS from the Mac Viewer.

To disable RADIUS:
1. While physically present at your host PC, right-click the system tray icon and choose Preferences.
2. Click the Authentication tab.
3. Click the Disable RADIUS button.
4. On the Change Access Code dialog box:
   - Enter your old access code.
   - Enter your new access code.
   - Confirm your new access code.
   - Click OK.
5. On the GoToMyPC Corporate Preferences dialog box click OK.

Note: You cannot disable the use of RADIUS unless your administrator has turned off the requirement to use RADIUS.
Managing Your Computers

Add or Remove a Host Mac or PC

You can add, remove and reinstall existing GoToMyPC seats at any time, which gives you the flexibility to rotate hosts on your account. If you want to add or remove the total number of seats then please see How to Change Your GoToMyPC Plan.

To add or reinstall a host Mac or PC to your account

1. Go to the Mac or PC you want to install GoToMyPC on.
2. Log in to your account at www.gotomypc.com so that you can view your existing host computers.
3. Click the Add Computer button at the bottom of the screen and then click the Install on this Computer button to install GoToMyPC.
4. Follow the normal installation process and register your host computer.

Note: Your ability to add computers will depend upon the plan you have purchased or, if you are a GoToMyPC Corporate user, the number of computers your administrator has authorized.

To remove a host Mac or PC from your account

1. Log in to your account at www.gotomypc.com so that you can view a list of your host computers.
2. Click the Options link next to the computer you wish to remove.
3. Click Remove to remove the host computer from your account.
4. You can now uninstall GoToMyPC from your computer just as you would any other application (this can be done at any time.)

Note: You may add and remove host computers as often as you wish. You may also want to consider upgrading your account to allow for a greater number of PCs to be permanently available to you. If you are a GoToMyPC Corporate user you cannot delete a Shared Access host computer if it is shared with another user. Contact your administrator to remove all shared-access users so that you can delete your host computer.

Revoke Desktop Shortcuts

Desktop Shortcuts are a great way to save time and quickly begin a remote GoToMyPC session. If at anytime your desktop shortcut(s) are unneeded or left on an unsecured PC then you can easily revoke them from your online account.

To revoke all desktop shortcuts to your host computer

1. Log in to your account at www.gotomypc.com so that you can view a list of your host computer.
2. Click the Options link next to the host you wish revoke desktop shortcuts.
3. Click the Revoke button to invalidate all shortcuts to your host Mac or PC.
**Move Host Computers Between Accounts**

To move a host computer from one account (e.g., individual) to another account (e.g., Corporate account) you will need to uninstall and reinstall the GoToMyPC software for each computer you wish to move. Moving a host computer from one account to another is a two-step process.

**To move a registered computer to another account**

*Step One - Remove GoToMyPC from your host computer and account*

1. Log in to your original account at www.gotomypc.com so that you can view a list of your host computer(s).
2. Click the Options link next to the host computer you wish to remove; and then click the Remove button.
3. Next, uninstall GoToMyPC from your computer just as you would any other application (this can be done at any time.)

*Step Two - Add GoToMyPC to the new host computer*

2. From the Computers page click Add Computer to install GoToMyPC.

**Change Your Host Computer Nickname**

You can change your host computer’s nickname at anytime.

**To change your host computer nickname**

1. Log in to www.gotomypc.com and view the My Computers page.
2. Click on the Options link to edit the host computer settings.
3. In the Nickname field, type in the new nickname and click the Rename button. The Nickname is changed.
Change Account Password

To easily improve security it is a good idea to occasionally change your account password. For maximum security, your account password must contain at least 8 character and include both letters and numbers.

**Note:** If you are a GoToMyPC Pro or Corporate user, your administrator may require you to change your account password on a regular basis.

**To change your account password**

1. Log in to your account at [www.gotomypc.com](http://www.gotomypc.com).
2. In the left navigation bar, click the **My Account** link.
3. Enter your current password in the **User Information** section.
4. Enter your new account password and then re-enter to confirm.
5. Click **Save Changes** to complete the password change.


**Change Your Access Code**

Your access code is a unique password that you create for each of your host computers. It is stored only on your computer and never transmitted over the Internet. For security reasons it is important that your access code be different than your account password (which is the password you use to log in to the GoToMyPC Web site.)

**Note:** If you are a GoToMyPC Pro or Corporate user, your administrator may require you to change your access code on a regular basis.

**Change Your Access Code on a Mac or PC**

1. If you know your current access code then it can be changed either during a remote GoToMyPC session or in person. If you do not remember your access code then click the [Forgot your access code link?](#) for further instructions.

2. While you're sitting in front of your host, click on the icon in your Mac menu bar or if on a PC, right-click the icon in the system tray and select *Change Access Code*.

3. Enter your old access code and then enter your new access code two times.

4. Click **OK** to complete the change.
Shared Access (GoToMyPC Corporate only)

Shared Access is a feature available only on GoToMyPC Corporate accounts. If your company account is enabled with shared access, your administrator may give access rights to other users - most often people who manage your PC. For example, your company’s IT specialist may use GoToMyPC Corporate to remotely maintain your PC. If your administrator has enabled shared access to your PC, you will:

- Receive an email from GoToMyPC Customer Care notifying you that your administrator has enabled shared access on your PC with at least 1 other user.
- Be asked to provide the additional user with your access code. After the shared-access user’s initial login to your PC, it is recommended that you change your access code.

This feature is not available for Mac computers.

Access Codes for Shared Users

When a secondary user is granted access to a host PC, he or she inherits the owner’s access code from the time the invitation was granted. The secondary user will use this access code even if the owner changes his access code after sending the invitation. If the original access code is forgotten by both the secondary user and the owner, then the administrator will need to revoke the original invitation and grant a new one so that the secondary user can inherit the new access code. If the secondary user has physical access to the host PC, he can change the access code by following the steps described in the Forgot Host PC Access Code section.

Note: If a shared access user fails to log in after 3 attempts, all users who have access to that PC will be locked out. Contact your administrator to unlock the Shared Access host PC.

If you have any questions about shared access to your PC, please contact your administrator.

In-Session Reboot

The In-Session Reboot feature enables you to remotely reboot your host PC and log back in with your Windows login credentials. This is an exclusive feature to accounts that have the Shared Access feature enabled. Since the In-Session Reboot feature is not a default setting, it must first be enabled by your administrator at the user or group level in the GoToMyPC Administration Center.
What it means when your Host Computer is In Session

If you log in to your GoToMyPC account and see that the My Computers page is displaying that one of your computers is In Session, then one of three conditions, or a combination of conditions, may exist. The three conditions are:

- You have not reloaded the My Computers page since you last connected to your host Mac or PC. Click the browser refresh button to reload the page and the In Session notification should disappear.
- The host computer has not yet set notification to the Citrix Online servers that it is no longer in session. Wait a few minutes and reload the My Computers page and the In Session notification should disappear.
- You are on a GoToMyPC Corporate account with Shared Access and the PC is a shared PC that is being accessed by another user on the GoToMyPC Corporate account. If you click the connect button you will disconnect the user that is in session with the host PC. If you have any questions about shared access to your PC, please contact your administrator.
Setting Preferences

GoToMyPC has several options that can be configured to suit your personal needs. You can set preference settings for:

- **Host:** Customize how the GoToMyPC service starts and runs
- **Viewer:** Change the way your Viewer window is displayed
- **Performance:** Adjust the speed, color quality and display settings to best suit your needs
- **Sound:** Optimize your session for system sounds or music depending on your sound card, personal preferences and the speed of your network connection.
- **Security:** Customize security options for your host computer
- **Authentication:** Configure settings for the host computer access code, use of One-Time Passwords (OTPs) and configuring RADIUS integration
- **Printing:** Add or delete printers for remote printing

To set preferences

1. Right-click the icon in the system tray of the host PC and select **Preferences**.
   - or -
   Access **Preferences** from the **Tools** menu in the **Viewer** window.
2. Select the appropriate tab for the set of preferences you want to customize.
3. Select your preferences.
4. Click **OK**.

*Note:* Your Preferences options may be affected by the type of operating system you are running and the type of rights your user account allows. Grayed-out options are not available for selection with your operating system or for the rights assigned to your computer profile.

Setting preferences for Mac computers is not available at this time.
Host Preferences

The host preferences option enables you to configure settings for the host computer.

- **Choose how to start GoToMyPC:**
  - *Run GoToMyPC automatically:* Start GoToMyPC when you start your computer (default) or when you log in (optional for users with administrative rights). To ensure maximum availability of the host computer, we recommend you choose to start GoToMyPC Personal automatically after startup.
  - *Run GoToMyPC manually:* GoToMyPC will start only when you launch the application from your Programs menu.

- **Choose desktop options while connected:**
  - *Automatically adjust host screen area for best full-screen viewing:* If possible, it will resize the host PC screen resolution to best match the client computer resolution.
  - *Disable sleep mode on host computer:* Disables sleep mode so the host computer remains accessible.
  - *Show host PC cursor:* Enables the viewing of both host and client cursors.

- **Desktop Notifications (Personal and Pro only):** Delivers access to complimentary Citrix Online upgrades, information, news and discounts that you may be eligible for. For more information see Desktop Notifications.

- **Authorization ID (GoToMyPC Corporate only):** Provides host PC MAC Address and C: Drive Serial Number for use when host PC authorization is required by administrators.

*Note:* MAC addresses cannot be used for authorization when either the host PC or client computer connects to the Internet via a dial-up modem because, unlike with Ethernet and Wireless network adaptors, dial-up modems don't have MAC addresses. In these cases, using the C: drive serial number of the computer is the option if Host or Client Authorization is desired. The options you have available for this preference may be affected by the type of operating system you are running and the nature of the rights your log in allows. Grayed-out options are not available for selection with your operating system.

Setting preferences for Mac computers is not available at this time.
Viewer Preferences

The Viewer preferences option enables you to configure settings for the Viewer window.

- **Screen size:**
  - **Start Host desktop in:** Choose to start the host PC desktop in either full-screen mode or Window (in Viewer) mode.
  - **Show Host screen:** Choose to view the host desktop image in actual size (may require scrolling in the Viewer) or scale-to-fit.

- **Viewer options:**
  - **Show update regions:** Provides an outline around the area of the screen that is redrawn when your Viewer refreshes its image.
  - **Dim Viewer when inactive:** Dims your Viewer window whenever you switch to your local client PC window.
  - **Copy/paste between computers:** Enables cut, copy and paste text between host PC and client PC.
  - **Pass Windows keys to host:** Enables special key combinations such as Alt-Tab and Alt-Shift-Tab, Windows key and Print Screen to be passed to the Host PC.
  
  **Note:** This feature is not available from the Universal Viewer.

- **Select Viewer color:** Enables you to change the color of your Viewer window.

**Note:** Your Preferences options may be affected by the type of operating system you are running and the type of rights your user account allows. Grayed-out options are not available for selection with your operating system or for the rights assigned to your computer profile.

Setting preferences for Mac computers is not available at this time.
**Performance Preferences**

The Performance preferences option enables you to adjust the speed, color quality and display settings to get the performance that best suits your needs.

- **Color Quality:**
  - *True Color*: Select True Color for better appearance.
  - *256 Colors*: Select 256 Colors for better speed.

- **Performance:**
  - *Better Speed*: Move the slider to the left to disable settings that affect performance. The disabled settings will be displayed in the bottom pane.
  - *Better Appearance*: Move the slider to the right to enable settings that affect appearance.

- **Performance History:**
  - Click the Performance History link to review current and historical session performance and improvement tips.

*Note:* Your Preferences options may be affected by the type of operating system you are running and the type of rights your user account allows. Grayed-out options are not available for selection with your operating system or for the rights assigned to your computer profile.

Setting preferences for Mac computers is not available at this time.
Sound Preferences

GoToMyPC supports one-way sound from your host PC to your client PC. The sound settings can be optimized for system sounds or music depending on your sound card, personal preferences and the speed of your network connection.

- **When my session starts:**
  - **Turn off sound:** Select this option to optimize performance.
  - **Use Low Quality Sound:** Enables lower quality sound for better performance.
  - **Use High Quality Sound:** Select this option if you intend to listen to music from your host PC.

**Note:** The High Quality Sound option is not available on Windows Vista.

- **Sound options:**
  - **GoToMyPC will play sound from:** Select your preferred audio source or let GoToMyPC detect the source automatically.
  - **Automatically disable sound if network connection is slow:** This option automatically disables the Sound feature if a slow network connection is detected. If the network performance improves, you will need to manually enable the Sound feature.
  - **Mute speakers while in-session:** Leave this option checked for in-session privacy.

**Note:** If you are listening to music from your host PC, be sure to stop the music before disconnecting your session. If you do not stop the music on the host PC before disconnection, the music will no longer be muted and could be heard by anyone close to your host PC.

Setting preferences for Mac computers is not available at this time.
**Security Preferences**

The security preferences option enables you to configure additional security settings.

- **Lock Upon Disconnection:** Automatically lock the host computer when you end your GoToMyPC connection.
- **Screen Blanking:** Enables you to blank out the screen of the unattended host PC while you are remotely connected.
  
  **Note:** Hardware limitations may prevent host PC screen blanking from working with multiple monitors using a single video card.

- **Keyboard/Mouse Locking:** This security feature prevents others from using your host mouse or keyboard while you are remotely connected.

- **Viewer Security Time-Out:** Enables you to set the amount of time in minutes for the Viewer window to time-out if no mouse or keyboard activity is detected. Default for this setting is 15 minutes.

Setting preferences for Mac computers is not available at this time.

**Note:** To maximize your security, we recommend that you enable all security settings.

If no mouse or keyboard activity is detected on your Mac for 30 minutes the Inactivity Time-Out feature will automatically disconnect your session. GoToMyPC Corporate can set the inactivity time-out to something greater than 30 minutes.
Authentication Preferences

The authentication preferences option enables you to configure settings for the host computer access code, use of One-Time Passwords (OTPs), and configuring RADIUS integration (GoToMyPC Corporate only.) If you are a GoToMyPC Corporate account user and the Shared Access feature is turned on by your administrator, you can view information on your host PC’s accessibility.

- **Access Code:** All users are required to have an access code for each host computer. The access code is only stored on the host computer and is never transmitted across the Internet.
  - *Change Access Code:* Enables you to change your access code by entering your old access code, entering a new access code and confirming the new access code.
  - *Forgot the Access Code:* Click the Forgot it? link and enter your email address and password to reset your access code. You must by physically present at the computer to reset it.

- **One-Time Passwords:** Provides the ability to enable the use of One-Time Passwords and to generate password lists. One-Time Passwords is a secondary authentication method that requires you to enter a string of one-use passwords in addition to your access code to access your host computer.
  - *Enable OTPs:* Turns on the requirement to use One-Time Passwords.
  - *Generate OTPs:* Generates a new list of One-Time Passwords.
  
    **Note:** To disable One-Time Passwords, you must be physically present at your host computer and will be required to change your access code. If you are a GoToMyPC Corporate account user, the One-Time Passwords feature will not be available to you if your administrator has designated your account a Shared Access host.

- **Configure RADIUS:** Enables you or your administrator to enter configuration information to enable the host PC to communicate with the RADIUS servers. Configuration information required is: RADIUS server name, RADIUS user name and RADIUS encryption key.
  
    **Note:** RADIUS Integration is only available if you have GoToMyPC Corporate and your administrator has required the use of RADIUS. This option will not appear to users who are not configured to use RADIUS.

- **Shared Access (GoToMyPC Corporate Only):** If you are a corporate user and your administrator has designated your host PC as a Shared Access host computer, this section displays the PC name and the number of users who have access to it.

Setting preferences for Mac computers is not available at this time.
**Printing Preferences**

With the Remote Printing feature PC users can easily print remote files to a local printer. No need to [transfer files](#) before printing or worrying if the correct application is installed on the local computer.

- For most print jobs we recommend simply using the [GoToMyPC Printer](#) which can be found in your remote application's print window. By selecting the GoToMyPC Printer where you start a print project, you will automatically print the remote document to your local computer's default printer. Please see [changing your printer](#) for more information on how to use a printer other than your current default printer.

- If a high level of precision is required for your project then you may want to [manually enable a printer](#). Once enabled, your printer will be displayed here in the **Printing Preferences** window. It is in this window that you can set a default or decide which printer to use during the current session.

**Note:** To simplify the remote printer setup, we recommend that you configure a printer while connected to your host computer from a client computer.

[Setting preferences for Mac computers is not available at this time.](#)
**Connections Preferences**

The Connections preferences option enables you to test the status of your host computer connection.

**To test the status of your connection**

1. Right-click the icon in the system tray of the host PC and select Preferences.
   - or -
   You may also access Preferences from the Tools menu in the Viewer window.
2. Select the Connections tab.
3. Click the Test Connection button.

**Note:** To ensure a valid connection test, we advise that you refrain from testing your connections unless a GoToMyPC customer-support representative directs you to perform the connection test.

Setting preferences for Mac computers is not available at this time.
Desktop Notifications (GoToMyPC and GoToMyPC Pro)

What are Desktop Notifications?
Desktop Notifications is a free GoToMyPC feature designed to deliver simple and effortless access to complimentary Citrix Online software upgrades, information, news and discounts you may be eligible for. Desktop Notifications delivers information right to your desktop, allowing you to safely receive important product information that is relevant to you. Desktop Notifications are sent only by Citrix Online as a service to our customers.

How does it work?
Occasionally, when connected to the Internet, Desktop Notifications will automatically connect with Citrix servers to see if there are any new messages for you. If there is a message on the server, Desktop Notifications will display the message on your computer screen. On a PC, Desktop Notifications can be enabled from the Host Preferences window.

This feature is not available for Mac computers.
Security Tips

GoToMyPC provides stringent built-in security features so that you can confidently access your PC from anywhere. For added security, here are a few things you can do.

1. Keep Your Password and Access Code Secure
   - Maintaining password security is the best way to protect your GoToMyPC account and host PC. Don’t share your password with anyone, and change your password regularly. PC users can change your access code from the host by right-clicking the system tray icon and selecting Change Access Code. Mac users click on the icon in the Mac menu bar and selecting Change Access Code.
   - GoToMyPC requires that your passwords have at least eight characters that include letters and numbers. When choosing your passwords, do not use common or easily guessed words. For the highest level of security, your account password and host computer access code should be different.
   - When using shared or public computers, exercise special care by not using GoToMyPC Remember Me feature to log in automatically. Additionally, you should not use your Web browser’s “auto complete” feature.
   - Use the One-Time Passwords feature for additional protection when traveling and using public terminals.

2. Protect Your Host Computer When Remotely Connected
   - Use the Blank Host PC Screen feature to prevent someone at your host computer from viewing your activity (most configurations).
   - Use the Lock Host Keyboard and Mouse feature to prevent others from using your host computer mouse and keyboard when you are remotely connected (this option available for most operating systems). PC users can enable these features from the Security tab of GoToMyPC Preferences.

3. Use Safety Features When Inviting Guests
   - You choose the expiration period for each invitation so you know when to be available when your guest arrives. The invitation expires if the guest does not connect to your host PC within your designated period. Because the invitation automatically expires, your guest cannot attempt to connect when you are away from your computer.
   - You choose the level of access to grant your invited guests. To limit a guest’s access to your computer, grant view-only control. Alternatively, you can allow full control of your keyboard and mouse.

4. Completely Disconnect
   - Make sure to completely disconnect when you are finished by closing the Viewer and logging out of the GoToMyPC Web site.
   - Be certain that you do not leave the client computer while you are remotely connected to your host Mac or PC.
   - When you log out, remember that if you do not close the programs you were last working on, they will remain visible the next time you access your host. Make sure to close any sensitive documents or programs before you disconnect.
   - You can have GoToMyPC automatically lock your host computer when you end your session. This prevents someone at your host PC from using your computer after you have disconnected. PC users can enable this feature from the Security tab of GoToMyPC Preferences.

Note: Although GoToMyPC has built-in protection features, by far the best protection is simply not to give out or compromise your user name, password or computer access code!
Protecting the Data Stream During a Session

GoToMyPC uses built-in 128-bit AES encryption so that all your data — including screen images, file transfers, keyboard and mouse input and chat text — is fully encrypted from end-to-end.

The encryption key is unique for each connection and is based on the host computer access code and a random bit sequence.

The access code is not stored anywhere on your host PC and is never transmitted or stored on Citrix Online servers. For this reason, it is impossible, even with the most sophisticated devices, to intercept the data necessary to decode the encryption. This ensures that transmissions cannot be hacked or compromised in any way.
FAQs and Troubleshooting

General FAQ

Can multiple accounts be set up on one host computer?
No. Multiple accounts cannot be set up on one host computer. If a computer is already registered to one account as a host and another user wants to add that same computer as a host onto their account, the first account will be overridden. In other words, the most recent user who added that computer to their account will have sole access.

I have two computers under my GoToMyPC account. Can I access both my computers at the same time?
Yes, you may access two different computers at the same time. To do this, wait for a connection to be established on one computer and then go back to our GoToMyPC Web page and connect to the other computer. Please note that you may experience an increased lag time due to the multiple connections.

What are my subscription options once my GoToMyPC personal plan expires?
You can now manage your GoToMyPC Personal subscription online and pre-select what happens to your account when your current plan expires. To modify your selection, log in to your account at www.gotomypc.com and select My Account from the navigation menu on the top left of your screen. Next, select Billing Info and then scroll to the bottom of the page to Subscription Options. From here you can select whether the account should be renewed or canceled at the end of your current plan.

Can I cancel my GoToMyPC personal account online?
Yes, to cancel your service, please log in to your account at www.gotomypc.com. Select My Account and update your subscription options on the Billing Info page. You can also call Customer Care toll-free at (888) 259-3826. If you are calling from outside the United States or Canada, please use one of our international telephone numbers.

Because GoToMyPC is a pre-paid service, your service will continue until the end of your current paid subscription period. At that time, your plan will be discontinued and will not renew again. Depending on the timing of your credit card billing cycle, your final charge may appear on your next statement. Please note that there are no refunds for service. Your plan will continue until its normal end date. Log in to review the active dates of service for your account.

How do I install GoToMyPC on my new computer and take it off the old one?
To free up your GoToMyPC seat, first log in to your GoToMyPC My Computers page. Click the Options link to edit the host computer you wish to remove and then click the Delete button. Next, go to your old host computer and uninstall GoToMyPC. Finally, log in to your GoToMyPC My Computers page from your new PC and install GoToMyPC. Please see Move a Host Computer for more information.

My company has the Shared Access feature enabled. Can I delete my host PC if it’s shared with another user?
No, you cannot delete your host PC if it is shared with one or more users. Your administrator must remove all shared-access users before you can delete the host PC from your account.
Is there a way to stop GoToMyPC from automatically launching?
You can start GoToMyPC manually by right-clicking the icon in the system tray and choosing Preferences. Under the Host tab, uncheck Automatically and then click OK.

Can GoToMyPC run without having the GoToMyPC icon active in the system tray?
No, GoToMyPC must be running for you to access the host computer.

Setup FAQ

Can I install GoToMyPC 6.0 on a Windows 95, 98, ME or NT computer?
No. GoToMyPC 6.0 or later must be installed on a PC with Windows 2000, XP, Vista, Windows 7 or Mac OS X 10.4 or newer. You can remotely connect to your host PC from computers with older operating systems. Please see the System Requirements section for more information. If installation is attempted on a PC with an older OS, you will be redirected to install GoToMyPC 5.0.

I tried to use your product, but cannot get past the window that asks for my user name and password. Help!
In this case, you are stuck in the authentication loop. This usually means that the computer you are on is behind a firewall. Our product, currently, cannot get through some highly-selective firewall systems. As a possible work-around, in addition to the usual ports 80 and 443 that are used to access the Internet, we suggest opening port 8200. Please see www.gotoassist.com/iprange for current IP addresses. If you use personal firewall software, make sure GoToMyPC has been added to its list of software that is allowed to access the Internet.

The GoToMyPC icon in the system tray has a yellow exclamation point. What does this mean?
The icon generally indicates that you did not complete the set-up and installation process. Please right-click on our icon in the system tray and select Register. This will bring you back to where you previously quit the installation process.

Sometimes your icon on the bottom has a red "x." What does this mean?
The icon means that your computer is not connected to the Internet or cannot access the GoToMyPC servers. If the problem persists, please check to see if there is a firewall (personal or corporate) or proxy server.

Session FAQ

I get horizontal lines on my screen when I access the host computer. How do I get rid of this?
You may see this if your host computer is scheduled to go into "Sleep Mode", has a screen saver or has an open DOS program. Click in the center of the viewer multiple times or access the Tools menu and then select Send Ctrl-Alt-Del to wake up the computer.

Why do I see a blinking cursor on the host computer?
GoToMyPC is unable to blank the cursor with certain video cards. Try turning off the monitor on the host computer.
How can I transfer more than one file at a time?
You can select more than one file at a time by holding down the <Ctrl> key while selecting files with the mouse.

The resolution is very bad. I can barely make out the icons on my desktop or read my email text. What can I do to clear this up?
When you connect to a host PC with a resolution set higher than the client, GoToMyPC automatically condenses the host desktop image in the viewer. You can resize the image of the host computer's desktop from the View menu. You can also try modifying the host computer’s screen resolution in the Screen Properties control panel.

I am getting a bluish screen or purple boxes on my screen when I connect.
Right-click on the host PC’s desktop and select Properties. Click on the Settings tab, change the color to 16-bit and then click Apply.

I cannot connect from my client computer.
Be sure that the Java settings are enabled in the browser and then reboot. Modify any firewalls to accept GoToMyPC. See Using GoToMyPC with Firewalls for more information.

I am running Windows XP and would like to switch users while connected to my host PC. Will I be disconnected or lose any information?
Fast User Switching allows you to connect to your host computer regardless of which user (if any) is active at that time. Once connected to your host PC, you can switch users at any time; however, any queued or active file transfers and remote printing jobs in progress are terminated when a user switch is performed. A black screen with a status message is displayed when a user switch is taking place. We recommend that you avoid logging off your PC from the Task Manager Users Page when using Windows XP Fast User Switching since this may shut down GoToMyPC. Fast User Switching is available on XP and later, including Vista.

Why are the letters the wrong case (Shift and/or Caps Lock do not work properly) when the Input Blocking feature is enabled on Windows XP?
Some versions of Windows XP have an issue with Input Blocking. To resolve, install Windows XP Service Pack 2 or go to Windows Update and install all of the Critical Updates.

Printing FAQ

I am trying to print checks with the GoToMyPC Printer but the alignment is off
Manually enable the client computer's printer when precision printing is required. Please see the section titled Remote Printing for details.

I am unable to print to my Dell or Lexmark printer from my client computer
Complete the following steps with administrative rights on the client computer:
1. Click Start, Settings and then Printers and Faxes.
2. Right-click on the Lexmark or Dell printer you plan to use and select Properties.
3. Select the **Advanced** tab and then click the **Print Processor** button.
4. If the default is set to LEMF, change it to NT EMF 1.008.
5. Click **OK**.

**Note:** Changing the default data type to NT EMF 1.008 should allow you to use the GoToMyPC Printer for remote printing but it could impact your regular print projects. If you notice subtle differences in the color output or have problems with special print features you will need to change the default data type back to LEMF.

---

**I was trying to set up a remote printer and now I’ve lost my connection.**

Some printers require a host computer reboot upon setup. This requires the GoToMyPC startup preference to be set to start automatically. Before you begin setting up remote printing, make sure GoToMyPC is set to start up automatically: Right-click the icon in the system tray of your host PC and select **Preferences > Host.** Under Start GoToMyPC, check “Automatically” and select “After startup.” If your preference was set to start GoToMyPC manually and the printer you were setting up required a reboot, your connection will have been lost and the printer installation will have to be repeated. Physically go to your host computer and reboot. Navigate to the newly created printer by clicking Start, Settings, Control Panel and then double-clicking Printers and Faxes. Delete the new printer and restart the printer setup process. Administrator privileges may be required to remove the printer.

**I am not sure which options to select in the Printer Setup Wizard during the printer setup process.**

Read and follow the tips in the GoToMyPC Printer Setup Wizard Tips window to the left of the Printer Setup Wizard window or read the [Remote Printing](#) setup directions.

**I can’t find my printer manufacturer, printer or printer driver in the Printer Setup Wizard process.**

The Window's operating system you are running does not have your printer’s driver in its database. Download and install the printer driver from the manufacturer’s Web site and select the "Have Disk" option in the Printer Setup Wizard when prompted for the manufacturer and printer.

**I can’t get GoToMyPC to recognize the printer driver.**

The printer manufacturer may require a custom installation. While remotely connected to your GoToMyPC host computer, download the driver for the client printer from the manufacturer’s Web site to the host computer.

Install the driver on the host computer. The installation will depend on the install packaging of each driver so be sure to follow the manufacturer’s install instructions. When prompted for the printer port, accept the default selection.

Once the installation is complete, click **Start, Settings** and then **Printers.** Right-click on the newly installed printer and click **Properties.** Click on the **Ports** tab. In the list of ports, select the "GoToPort”. Click **OK**.

It is recommended that you add GoToMyPC as a preface to the printer name. To do this, in Printers, right click on the newly installed printer and click **Rename.** Enter "GoToMyPC –" to the beginning of the name so you will know that this printer is for GoToMyPC.
From the GoToMyPC Viewer menu select Tools, Preferences and then the Printing tab. The new printer is listed as GoToMyPC Printer and you are ready to print from the client computer.

I receive an error message telling me that I do not have the proper permissions or "Administrator Rights" to install a printer driver.
This is due to your user profile rights. You need to have administrator rights to install printer drivers. Please see Windows help or your network administrator for help ensuring you have administrator rights to install GoToMyPC.

I downloaded and installed the printer driver and completed the setup process, but it prints incomprehensible text.
You may have the wrong printer driver on the host computer for the client computer’s printer.
Make sure the printer driver you installed on your host computer matches the printer model you are trying to print to on the client computer. Also, make sure you have the correct driver version for your operating system.

I clicked the print icon on the toolbar of my application but it did not print to the client printer (or printed to the host).
The GoToMyPC Printer may not be selected as the default printer while in session. To make the GoToMyPC Printer the default while in session, change the Printing Preferences so the GoToMyPC Printer is automatically set as the in-session default.
If you do not want the GoToMyPC Printer to be default while in session, you will need to print by going to File > Print in your application and select the GoToMyPC Printer.

I receive the error message: “There was an error found when printing the document <document_name> to GoToPort:. Do you want to retry or cancel the job?”
You are trying to print to the GoToMyPC printer when the GoToMyPC session is over. Some applications remember which printer was used the last time the document was printed. Print from the file command in your application and select a non-GoToMyPC printer.
- or -
The default printer was not restored after the GoToMyPC session ended. Open the Windows printer folder, select a non-GoToMyPC printer, and click Set as Default in the File menu.

PocketView FAQ
How do I install GoToMyPC PocketView?
You do not need to install PocketView. Once you have set up a GoToMyPC account and installed the software on your host PC, simply log in to the GoToMyPC Web site from your Windows Mobile, Pocket PC, or Windows CE device and choose the host PC you wish to connect to. You will then be presented with the download needed to connect to that computer. PocketView is not compatible with Blackberry or iPhone.
Do I have to download PocketView every time I connect to my remote computer?
You must download the loader program each time you connect, but it is only 50KB. Once the correct version of the main PocketView program (about 550KB) is downloaded, it will be cached on your device so it will not need to be downloaded again. To bypass the login screen and quickly begin a session, create a shortcut from the File menu.

Can I pre-install PocketView?
PocketView is installed through download-on-demand. If you want to avoid going through the initial download while using a slower wireless connection, connect once while the device is in its cradle (using ActiveSync for the Internet connection). After that, the main program will be cached and will not need to be downloaded again.

What kind of handheld device is needed to use PocketView?
PocketView supports Microsoft Windows Mobile 5.0 / 2003SE / 2003 for Pocket PC (including Phone Edition) and most devices running Windows CE 4.0 or later with a touch screen or mouse, such as thin clients. For more detailed information, please see the System Requirements section.

What kind of Internet connection is needed to use PocketView?
An Internet connection with a typical speed of at least 40 kbps is recommended.

How do I rotate the on-screen keyboard or other soft input panel?
If your device is running Windows Mobile 2003SE or later, you can rotate the screen using its built-in capability instead of using PocketView’s rotation. From the Start menu, choose Settings > System > Screen to change the device’s orientation.

How do I remove PocketView from my handheld device?
If you wish to remove the cached PocketView program, use File Explorer to navigate to Program Files\Citrix\GoToMyPC; locate the g2viewer.exe file and tap-and-hold it; and then select Delete from the popup menu.
GoToMyPC and Cookies

GoToMyPC requires that cookies be enabled on your Internet browser before you log in to begin a session. In most cases your browser is already configured to accept cookies but if not you can modify your security settings from your Internet browser.

To enable cookies in Microsoft Internet Explorer
1. From Internet Explorer select the Tools menu and then Internet Options.
2. From the Privacy tab set the Settings slider to High or below to accept cookies.

To enable cookies in Mozilla Firefox
1. From Firefox select the Tools menu and then Options.
2. From the Privacy tab check the boxes to accept cookies.

Note: If you prefer to only accept cookies from www.gotomypc.com then uncheck the box to accept cookies. Next click the Exceptions button, type www.gotomypc.com and then click Allow.
Using GoToMyPC with Firewalls

Firewalls are configured to block outgoing and incoming communications unless you authorize the program to allow them. You can use GoToMyPC with firewalls (ZoneAlarm, Norton Personal Firewall, etc.) installed on either a host computer or client computer. The table below lists the application components that need to be authorized in order for GoToMyPC to run on a PC.

<table>
<thead>
<tr>
<th>For the <strong>Host Computer</strong> (This is the PC you want to access from someplace else)</th>
<th>For the <strong>Client Computer</strong> (This is the computer you use to access the host computer)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primary Files</strong></td>
<td><strong>Primary Files</strong></td>
</tr>
<tr>
<td>g2comm.exe</td>
<td>g2comm.exe</td>
</tr>
<tr>
<td>g2fileh.exe</td>
<td>g2pre.exe</td>
</tr>
<tr>
<td>g2host.exe</td>
<td>g2processfactory.exe</td>
</tr>
<tr>
<td>g2mainh.exe</td>
<td></td>
</tr>
<tr>
<td>g2printh.exe</td>
<td></td>
</tr>
<tr>
<td>g2svc.exe</td>
<td></td>
</tr>
<tr>
<td>g2tray.exe</td>
<td></td>
</tr>
<tr>
<td>gopcsrv.exe</td>
<td></td>
</tr>
</tbody>
</table>

These programs need to be admitted through three ports: 80, 443 and 8200. One-way TCP connectivity is needed (TCP outbound). Should you need to authorize specific IP ranges, our IP ranges can be found here: [www.gotoassist.com/iprange](http://www.gotoassist.com/iprange).

Using GoToMyPC with a Firewall on a Host

Setting up a firewall to enable GoToMyPC to work requires that you take a little extra time to configure your software to allow GoToMyPC to run without interruption. Setting up GoToMyPC to work with a firewall involves three steps.

**To set up a firewall to allow GoToMyPC to run as a host**

**Step One: Enable GoToMyPC to access the Internet**

The first time you run GoToMyPC on a host computer that has a firewall installed, you will set off the firewall and be prompted to allow GoToMyPC to access the Internet.

1. Select the check box to "Remember the answer each time I use this program."
2. Click **Yes** to enable GoToMyPC to access the Internet.

**Step Two: Enable GoToMyPC to be the host computer**

Before you can remotely access a host computer you will need to authorize your firewall to allow the following GoToMyPC files to access the Internet: g2audioh.exe, g2comm.exe, g2fileh.exe, g2host.exe, g2mainh.exe, g2pre.exe, g2printh.exe, G2ProcessFactory.exe, g2svc.exe, g2tray.exe, gopcsrv.exe, g2vistahelper.exe.

You must be physically present to authorize these files on your host computer.

1. When prompted for each component, select the check box to "Remember the answer each time I use this program."
2. When prompted for each component, click Yes to enable each component to access the Internet.

**Note:** Be sure to disable Host Screen Blanking and Keyboard Locking on the GoToMyPC security preferences window prior to connecting with that host PC.

**Step Three: Configure your firewall to accept all GoToMyPC files**

1. Open your firewall console and manually select the option to allow each of the above components. After doing this once, you should not need to repeat this process again.

**Using GoToMyPC with Norton Internet Security Firewall on a Host**

- **To set up a Norton firewall to allow GoToMyPC to run as a host**
  1. While physically present, right-click on the Norton Internet Security icon on your host computer’s system tray.
  2. Select Open Norton Internet Security from the system tray menu.
  3. Select Personal Firewall from the Status & Settings menu and click the Configure button.
  4. Select the Programs tab, locate GoToMyPC and then click Add.
  5. To begin adding files, click on g2audioh.exe and click Open.
  6. From the Program Control prompt select Permit from the drop down menu and click OK.
  7. Repeat these two steps to add the remaining GoToMyPC files:
     - g2comm.exe
     - g2fileh.exe
     - g2host.exe
     - g2mainh.exe
     - g2pre.exe
     - g2printh.exe
     - G2ProcessFactory.exe
     - g2svc.exe
     - g2tray.exe
     - gopcsrv.exe
     - g2vistahelper.exe

**Using GoToMyPC with Norton Transaction Protection on a Host**

If your version of Norton Internet Security has the Norton Transaction Protection feature enabled, you may need to adjust your Norton settings in order to view your host computer’s desktop. If GoToMyPC is installed on your host PC but you are unable to view your desktop while remotely connected please follow these instructions.

- **To set Norton Transaction Protection to allow GoToMyPC to run**
  1. If you have not already done so, install GoToMyPC and attempt to remotely connect to your host computer. Norton's Transaction Protection allows the connection but will blank out your host PC's desktop.
  2. End the session and return to your host PC.
  3. While physically present, right-click on the Norton Internet Security icon on the host computer’s system tray.
  4. Select Open Norton Internet Security from the system tray menu.
  5. Click on the Norton Internet Security tab at the top of the Norton window.
  6. From the Settings drop-down list, click the Norton Internet Security Options link.
  7. Click the Transaction Protection link from the left side of the window.
  8. Change the status to allow g2host.exe and then click OK.
Using GoToMyPC with ZoneAlarm Firewall on a Host

To set up a ZoneAlarm firewall to allow GoToMyPC to run as a host PC

1. While physically present, double-click the ZoneAlarm icon on your host computer’s system tray.
2. Select Program Control from the menu on the left.
3. Verify that you are viewing the Programs tab.
4. Click the Add button on the bottom-right of the screen.
5. Navigate to the GoToMyPC folder on your computer (C:\Program Files\Citrix\GoToMyPC).
6. Highlight all of the GoToMyPC files in that folder and click Open to add the GoToMyPC files.
7. Locate the GoToMyPC file in the Programs list, click the ? icon in the Trust Level column and select Super. Repeat this step for each of the GoToMyPC files.
8. Finally, click each ? icon in the Access and Server columns that correspond to a GoToMyPC program and select Allow.

<table>
<thead>
<tr>
<th>Active</th>
<th>Programs</th>
<th>Trust Level</th>
<th>Access</th>
<th>Server</th>
<th>Send Mail</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>GoToMyPC Host Loader</td>
<td>?</td>
<td>?</td>
<td>?</td>
<td>?</td>
</tr>
<tr>
<td></td>
<td>GoToMyPC Vista Helper</td>
<td>?</td>
<td>?</td>
<td>?</td>
<td>?</td>
</tr>
<tr>
<td></td>
<td>GoToMyPC Remote Desktop</td>
<td>?</td>
<td>?</td>
<td>?</td>
<td>?</td>
</tr>
<tr>
<td></td>
<td>GoToMyPC Remote Control</td>
<td>?</td>
<td>?</td>
<td>?</td>
<td>?</td>
</tr>
</tbody>
</table>
**Sound Troubleshooting**

- The **Sound feature** is available on host computers with Windows 2000 or later. It is not available for Macs or on PocketView or the Universal Viewer.
- For optimal sound quality and to eliminate many sound problems, install the latest Windows Media Player on both the host computer and client computer.
- In rare cases, GoToMyPC is unable to detect the loopback input correctly. Manually select the loopback input from the drop-down menu in the **Sound Preferences** window. Typical names for the loopback input are: Stereo Mix, Wave Out Mix, What U Hear, Stereo Mixer, Sum and Stereo. This does not apply to PCs with Windows Vista.
  
  ![Sound Preferences Window](image)

- If the sound quality is poor, it might be because the Wave output is set to 100% on the host PC. Reduce the Wave output volume from the host PC Windows Volume Control panel. This does not apply to PCs with Windows Vista.
If the Sound feature is enabled but there is no sound, verify the speakers are securely connected to the client computer.

If you attempt to use Skype VoIP while remotely connected to your host computer, GoToMyPC may reconfigure the audio source which will disable the sound. To reactivate the Sound feature, turn sound off and then on by clicking the Sound button in the upper right corner of the Viewer window. This does not apply to PCs with Windows Vista.

If you receive the warning "Sound is still playing" upon disconnect after you disabled the music, GoToMyPC may be detecting sound at very low levels. This does not apply to PCs with Windows Vista.

**Sound Cards**

A sound card provides the audio component to your PC and is required on both the host and the client computer in order to use the Sound feature. The host PC sound card needs to have a loopback input device so that the computer can record what it is outputting. GoToMyPC 6.1 is compatible with a wide variety of sound card types but there are a few compatibility issues:

- A number of problems can be resolved by downloading and installing the latest driver from the sound card manufacturer’s Web site. See the instructions below to determine the sound card in your computer.
- There are known compatibility issues with older SigmaTel sound card drivers. Try installing the latest sound card driver with loopback input support. This does not apply to PCs with Windows Vista.
- On a few sound cards, GoToMyPC cannot capture sound if the host PC is muted or the sound volume is very low. If you have Realtek HD 88x or SoundBlaster Audigy SE, uncheck “Mute speakers on (your PC name) while in-session” in the Sound Preferences window. This does not apply to PCs with Windows Vista.
- Sound is not supported on host PC sound cards that do not have loopback input, which is typically an issue with USB sound cards. Installing the latest sound card driver may resolve this issue. This does not apply to PCs with Windows Vista.
To determine the sound card installed on your PC

1. Click the Windows Start button and then select the Programs folder.
2. Select Accessories, System Tools and then System Information.
3. From the System Information window, click the + symbol next to the Components folder.
4. Click Sound Device (or Multimedia and then Sound Device) and view the sound card details on the right.

Note: In cases where Windows installed a compatible sound card device, the listed sound card may not be the exact manufacturer and/or model installed in your computer.
**Forgot Your Account Password**

If you ever forget your account password you can quickly create a new one.

- **To create a new account password**
  1. Go to [www.gotomypc.com](http://www.gotomypc.com) and click the **Forgot your Password?** link below the **log in** button.
  2. Enter your email address that was used to create your account and click **Submit**.
     An email will be sent to your email address with a link to create a new account password.
  3. Go to your email and click the link to create a new account password.
     From the new Web page enter your new account password and confirm.
  4. Click **OK**.

**Note:** You will receive an email with instructions for creating a new password. The email will be sent to the email address you provided when you created your GoToMyPC account. If the email account is accessible only from the host computer you are trying to access, you will need to be physically present at your host to view the email.
Forgot Your Access Code

Your access code resides only on your host Mac or PC and is never transmitted over the Internet. It is a critical component in the encryption key which is used to keep your host computer secure. For security reasons, Citrix Online does not have a record of your access code and has no way to provide it to you if forgotten while traveling. Because it cannot be emailed, you must be physically present at the host Mac or PC to create a new access code.

To create a new access code
1. Go to the host Mac or PC whose access code you would like to change.
2. Make sure that the GoToMyPC service is running (PC users look for icon in the system tray; Mac users look for the icon in the Mac menu bar at the top of the screen).
3. Right-click the icon in the system tray or if on a Mac, click the icon in the menu bar and select Change Access Code.
4. Click the Forgot your access code? link.
5. Enter your email address and account Password.
6. On the New Access Code dialog box, enter your new access code, confirm and click OK.
Your Host Mac or PC is Offline

What is Offline?
If you log in to your GoToMyPC account and see that the My Computers page is showing that one of your PCs is Offline, then one of three conditions, or a combination of conditions, may exist.

The three conditions are:
- The host computer is powered off or in sleep mode
- The host computer is not connected to the Internet
- The GoToMyPC host software is not running

How do I make a PC available?
To make a Offline Mac or PC available for remote access, you will need to be at the computer and ensure that the following conditions are met:
- The host PC is turned ON (you do not need to be logged in and the for security reasons the computer should be locked)
- The host PC is connected to the Internet with a live Internet connection
- The GoToMyPC host PC software is running

To start the GoToMyPC service
- If GoToMyPC is not running on a PC then from your taskbar choose Start, Programs, Citrix and then GoToMyPC.

Note: If GoToMyPC is running on a PC, you will see the icon in the system tray.
To ensure GoToMyPC is available while your PC is turned ON

- From your **Host Preferences** make sure that GoToMyPC is set to start *Automatically* and that the *sleep mode* has been disabled. Without these items checked you will need to ensure that GoToMyPC is running and sleep mode has been disabled each time you leave the host computer unattended.

If you intend to remotely access a Mac laptop, keep in mind that the Internet connection is automatically disabled once the lid is closed.
Optimize GoToMyPC Performance

The speed of the session will depend on various factors, including type of OS, browser and Internet connection for both computers. Even if you have fast connections, Internet traffic on your ISP can affect your session.

System resources and programs using Internet bandwidth can also affect the exchange of information between the host computer and client computer. If your system meets the minimum recommended requirements but you are still experiencing a lag in performance, following are several items you can adjust to improve performance. You can also see Session Performance for more information.

To improve the performance of GoToMyPC

1. GoToMyPC works by detecting differences in the screen and redrawing it to show updates. If you are using a high-display resolution, you can try reducing it to a lesser value, such as the standard 800 x 600. If you are using a desktop or wallpaper with high-resolution picture or graphics, try changing to a plain background during your remote sessions. For more information in disabling effects, see Quality Preferences.
2. Free up bandwidth by closing any programs that take up bandwidth, such as AOL Instant Messenger, Yahoo Pager, chat programs or online "radio" stations.
3. Lack of system resources can also slow down the exchange of data. Close programs that are not being used. Some older operating systems may not release memory and resources even when programs are shut down, so you may want to reboot the host machine before setting it up for a remote connection.
4. Your ISP may have a lower upload rate. Many ISPs enable you to download at a faster rate than you can upload. If your host computer is connected to the Internet by an ISP — cable or DSL — you may need to check with your service provider to have your upload rate increased.
Network Authentication

If you are having trouble completing your network authentication, please select your operating system for assistance.

Windows 2000

To find your domain in Windows 2000

1. Right-click the Windows My Computer icon on your desktop, and select Properties.
2. Select the Network Identification tab.
3. The information shown for Domain: is the name of the Windows Domain to which your computer belongs on your company network.
4. Please note your domain name so that you can enter it into the Domain field of the Authentication Required dialog box.
Windows XP

To find your domain in Windows XP

1. Click the Start button.
2. Right-click the My Computer icon and select Properties.
3. Select the Computer Name tab.
4. The information shown for Domain: is the name of the Windows Domain to which your computer belongs on your company network.
5. Please note your domain name so that you can enter it into the Domain field of the Authentication Required dialog box.
**Connection Test Help**

Most connection test difficulties are related to user authentication issues. Please answer the question below to assist you with determining if this problem exists and what actions to take.

Did you see a dialog box titled ‘Authentication Required’ containing three fields labeled Domain, User Name and Password?

**Yes, I did see the ‘Authentication Required’ dialog box and I believe I entered all the correct information but I am still having trouble.**

The user name and password required here are the same as those that you use to log on to your Windows computer.

As when entering all user names and passwords, please make sure that:

- You are typing correctly, especially since you cannot see the password characters as you type them.
- Your Caps Lock key is off.
- You do not have any trailing white-space characters in the fields. Check this by deleting and retyping the entire contents of each field or by checking the end of each field for a blank space.

**Yes, I did see this dialog box but the 'Domain' field was empty or may be incorrect.**

Our software will attempt to fill in the Domain field for you. In rare cases this may not work, and the Domain field will be blank or an incorrect Domain will be shown.

You can easily determine and verify your correct Domain for the Domain field. To get instructions on how to do this, please click the link for your operating system:

- [Windows 2000](#)
- [Windows XP](#)

**Yes, I did see the ‘Authentication Required’ dialog box, but the 'Domain' field was absent.**

This dialog box indicates that ‘Basic Authentication’ is in use on your Web proxy. The user name and the password required here might be the same as those you use to log on to your Windows computer.

However, your Web proxy may require different passwords than those you use to log on to your Windows computer. Your network administrator can confirm whether or not you have the correct information.

As when entering all user names and passwords, please make sure that:

- You are typing correctly, especially since you cannot see the password characters as you type them.
- Your Caps Lock key is off.
- You do not have any trailing white-space characters in the fields. Check this by deleting and retyping the entire contents of each field, or by checking the end of each field for a blank space.
No, I did not see the 'Authentication Required' dialog box.
Please contact Customer Care at 1-888-259-3826.

Help, I followed the steps but I am still having trouble.
Please contact Customer Care at 1-888-259-3826.
Contact Customer Support

There are three types of GoToMyPC account. Please contact the support center best suited to support your version.

- **GoToMyPC** — Secure remote access for individual users
- **GoToMyPC Pro** — Secure remote access for teams and small companies
- **GoToMyPC Corporate** — Secure remote access for small and medium-sized businesses

**GoToMyPC**

- If you are experiencing problems with GoToMyPC or have questions, please contact:
  - Customer support: gotocustomercare@citrixonline.com
  - Billing questions: gotobilling@citrixonline.com
  - Feedback or comments: gotofeedback@citrixonline.com
  - To contact Customer Care by phone, please call:

<table>
<thead>
<tr>
<th>Country</th>
<th>Toll-Free</th>
<th>Direct Dial</th>
</tr>
</thead>
<tbody>
<tr>
<td>U.S. and Canada</td>
<td>888-259-3826</td>
<td>805-690-5750</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>0800-051-8895</td>
<td>001-805-690-5750</td>
</tr>
<tr>
<td>Europe</td>
<td>00-800-5744-2340</td>
<td>001-805-690-5750</td>
</tr>
<tr>
<td>Australia</td>
<td>0011-800-5744-2340</td>
<td>00111-805-690-5750</td>
</tr>
<tr>
<td>Mexico</td>
<td>001-800-574-4234</td>
<td>001-805-690-5750</td>
</tr>
<tr>
<td>India</td>
<td>000-800-100-3093</td>
<td>001-805-690-5750</td>
</tr>
<tr>
<td>New Zealand</td>
<td>00-800-5144-2340</td>
<td>001-805-690-5750</td>
</tr>
</tbody>
</table>

*Toll-free service unavailable in some areas

**GoToMyPC Pro**

To contact Customer Care with any GoToMyPC Pro account or billing questions, please contact:

- Customer Support: gotopro@citrixonline.com
- By phone, please call: 888-646-0020

**GoToMyPC Corporate**

If you are experiencing problems with GoToMyPC Corporate (you are a corporate customer with a dedicated account manager) or have questions, please contact your IT administrator or:

- Customer support: support@citrixonline.com